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Your Vision, our Plugins.

Rob Powers

Inspired
Artistry
We are so excited to share our new
LightWave 3D Magazine with you.
This issue goes cover-to-cover with
stories and tutorials that are all designed
to help inspire you to push the limits of
LightWave in everything you do.
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Whether you’re just getting started or an

As a small child I grew up by the sea; the intricate

experienced LightWave artist, inspiration (in all

ecosystems that exist there truly fascinated me. I

shapes and forms) can oftentimes be the catalyst

checked out every library book possible, covering

that opens the door to some pretty remarkable

everything from the various species of tropical fish

opportunities. I know firsthand because it

to marine invertebrates and corals from around the

happened for me.

world. I learned the animals’ names, characteristics

Like so many artists, the original 1977 Star Wars film
captured my attention and led to my fascination
with science fiction and visual effects. But for me
another huge inspiration also comes fromnature
and the ocean. The two would eventually intersect

and lifecycles; I was obsessed and driven to learn
everything possible on the subject. I watched
every documentary on marine life available and
spent hours reading the books and looking at the
colourful photos of sea life. It was my passion.

in my career.
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Fast forward ten years into my visual effects career, where my love
of nature (and technology) set me on a course I could never have
predicted; a chance meeting with director James Cameron. My friend
and producer Chuck Comisky arranged a meeting that would give me
a shot at working on one of Cameron’s upcoming feature films.

You never know when

My first meeting with James Cameron was iconic. Up to that point,

your passions can

he had been meeting with 3D computer animators who knew their

serve as an asset that
sets you apart from
everyone else.

Medical Modeling & Animation
in LightWave 11.x

way around the latest Siggraph white paper techniques or how to
write a shader for the latest buzzword rendering software; artists
who opted to focus on impressing him primarily with their mastery of
the technology. So while interviewing for a 3D animation and design
position on Cameron’s film, I demonstrated my mastery and technical
knowledge of the software tools, but something else emerged. While
sitting across the table listening to Cameron’s vision of the film, he
mentioned that the Spanish Dancer was a major reference for the
graceful motion he wanted to see in the extraterrestrial aquatic
creature for the film. It was at that moment that my lifelong passions
were realised in my art. I caught myself enthusiastically offering up
the details on the habitat, brilliant colouring, and sinusoidal swim
motion of the Spanish Dancer marine flatworm. For a split second I’m
certain I saw a slight twinkle in his eyes.
That one moment turned into an incredible five-year creative journey
that allowed me to work closely with Cameron as the first CG artist
to join his team and as a member of his hand-picked inner creative
circle dubbed the Malibu 5, referring to the first five members to join
influence the birth of amazing innovation for the production industry.
What’s more, as the supervisor and creator of the industry’s first
Virtual Art Department for Avatar, I was able to directly participate
in the evolution of virtual production workflows, which also opened

MY INSPIRATION

the door to working with other iconic directors. My passion for the

Rob Powers
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Powers have a shared
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led to Rob’s amazing journey

and design position on Cameron’s
film, I demonstrated my mastery
and technical knowledge of the
software tools, but something
else emerged. While sitting across
the table listening to Cameron’s
vision of the film, he mentioned
that the Spanish Dancer was a
major reference for the graceful
motion he wanted to see in the
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The brilliant colours
and patterns of the
Mandarin Goby Fish,
the bioluminescent
colours and graceful
motion of the deepsea jellyfish, and the
bizarre alien shape
of the seahorse
inspire me!

twitter.com/3DWorldMag

inner creative circle dubbed the
Malibu 5, referring to the first five
members to join the Avatar film
team. With this opportunity I was
able to witness and influence the
birth of amazing innovation for
the production industry.
What’s more, as the supervisor
and creator of the industry’s first
Virtual Art Department for Avatar,
I was able to directly participate
in the evolution of virtual
production workflows, which also
opened the door to working with
other iconic directors.
My passion for the creatures
of the ocean allowed me to know
something other artists didn’t, at
a time when I absolutely needed
to know it. Your mission is to fi nd
out what that thing is for you. And
if you ever hear me suggest getting
a tropical fish aquarium, you’ll
know what I really mean. Passion
fuels creativity.
Find out more about Rob Powers
FYI at www.lightwave3d.com

thing is for you. And if you ever hear me suggest getting a tropical
fish aquarium, you’ll know what I really mean. Passion fuels creativity.

As seen in
3D World
magazine.
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the Avatar film team. With this opportunity I was able to witness and

This brand new comprehensive video training course from leaders

In this comprehensive course, you’ll learn this awesome new program

Dan Ablan and 3DGarage.com will guide you through the creation

in a succinct, straight forward approach. Medical animations are

of 3D medical models and animation in LightWave 11.x.

a great field of business for 3D animators, independent or large

For more than 20 years, Dan Ablan has been working with and delivering

agencies. Learn how easy it is to build and create in LightWave 3D.

3D models and animation to clients in the health industry, including the

These new training tutorials also explain the latest features in

American Dental Association, Abbott, Baxter, and Fujisawa to name a

LightWave, building on the software’s core functionality that makes

few. Now he shows you how easy it is to use LightWave 3D to build cells,

it one of the leading 3D software programs in the industry.

create blood flow and cell divisions, and much more.

www.3dgarage.com
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By Karen Moltenbrey

3D Printing Pros

Rolling Large
with PropShop
Propshop creates unique movie objects, including a crazy car
for the recent Muppets movie

Dressing a movie set can be complicated. After

how it created these

all, where does one get the large, intricately

unique props for

detailed, signature hammer – Mjolnir – wielded

the film and the

by the superhero Thor? Or the magnificent

role

king’s staff and richly styled horse armor for

3D played in that

Maleficent? For years now, Propshop in London

process.

NEWS

LightWave

has been building one-of-a-kind objects designed
to suspend belief and transport audiences into

When did you start

the various film worlds created by the directors

creating props?

and art departments, whether for a visual gag or
Propshop has been making props for more than 15

visual intrigue.

years. I started using LightWave some 20 years ago
Recently, the company – which also designs, models,

– since the days of the Amiga, back when LightWave

and produces objects for the real world, such as

came on 10 floppy disks, in Version 3.5. When I

a World Cup sculpture for Nike signature stores

joined the company a few years ago, LightWave

and a replica of the Hastings Knight statue for a

became part of the process. One of our first pieces

commercial – was called upon to manufacture the

using LightWave was Cerebro for X-Men: First Class.

Interpol car for the recent Disney Muppets movie,

Since then, we have used LightWave to generate our

Muppets Most Wanted. But, this was no ordinary-

3D [imagery] for over 30 movies and productions.

looking vehicle. It had to reflect the zaniness one
would expect to find in a Muppets film. Moreover,
the vehicle had to be functional, as it was driven

Why did you select LightWave?

by Interpol Agent Jean Pierre Napoleon, played by

LightWave is fast, intuitive, and a ‘no-mess’ modeling

Actor Ty Burrell. The waist-high car is seen zipping

package. Here at Propshop, we have built a strong

through various scenes as the agent attempts to

and successful pipeline with LightWave as a

track down the notorious Constantine, who bears

foundation.

an uncanny resemblance to Kermit the Frog.
Propshop also created an oversized badge as Napoleon and CIA Agent Sam the Eagle play a game
of one-upmanship when comparing credentials in
the film.

in the design and manufacture of hero props, set
pieces, costumes, models, and miniatures using
a combination of LightWave 3D and 3D printing.
Here, the team at Propshop, including Jet Cooper,
3D supervisor in the Digital department, discusses

LightWave Magazine Summer 2014 | www.lightwave3d.com

I use LightWave to build all my 3D models before
they go to print. LightWave is also used in the
designing/concepting process, with its renderer

Located at Pinewood Studios, Propshop specializes

10

How is LightWave used in your prop creation?

being utilized for animations to explain a prop’s
form, function, and final look. The Modeler is
fast and capable of achieving models that are
organic, hard-surfaced, and extremely complex.
Propshop has been able to create anything with the
LightWave Modeler.

LightWave Magazine Summer 2014 | www.lightwave3d.com
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3D Printing Pros

How has 3D printing evolved to enable you to create

LightWave is fast, intuitive,
and a ‘no-mess’ modeling package.

props like you do?
3D printing has become faster, and the volume is larger so that
larger-size parts can be printed as a whole. Our large 3D prints
can now range up to 1.6 meters (5.25 feet) per piece and print
overnight! Our printers now recycle non-used material, thus
reducing costs and waste.

What kind of 3D printer do you use?
We primarily used Voxeljet printers, which lay down a fine
plastic powder and binding agent. The end result is a strong
print that can be tooled and finished in many different ways.

Was

Concepts
Let’s talk about the car. Was the design based on an

How was LightWave used in

actual vehicle?

the car creation process?

The design of the car was originally based on an old Russian

The car was modeled using

car. However, this changed to a completely different

subdivision surfaces and con-

hybrid over the course of the project. There were different

cept artwork. The 3D car was

versions that evolved as we corresponded with the movie’s

then frozen to make a high-re-

art department. As reference, the Muppets art department

solution poly mesh that could

provided a few photos of Russian cars and some sketches

be exported to produce a ‘wa-

suggesting the form they had in mind.

ter-tight,’ printable STL file that
is used by our 3D printers.

Which tools did you use to create the vehicle?
The car designs were modeled with

LightWave 11 and

polished with Pixologic’s ZBrush when and where required.

What kind of challenges did you face?

This is a large prop. Can you provide some details about
the file and the prep work required to 3D print it?

issue – we have printed much
larger things before, such as an
entire spacecraft. We just cut any
oversize parts into pieces and
join them upon assembly.

Why do you use 3D printing as part of the manufacturing

3D printing allowed us to generate a design that could be
adjusted and modified on the fly, whereas the traditional
methods take longer and are harder to change as problems

tally cut to fit our large printing beds – for example, the main

the artwork, we use that signed-off model to produce the
actual hero prop. That way, there is no deviation from what

so forth. The file sizes ranged between a few megabytes up

the art department and director have seen and approved.

and art department while producing a model that can be

to a few hundred megabytes. These file sizes are larger due

manufactured in a working and practical form.

to the fact that the planes in the geometry have to be small

12
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produce good results on Propshop’s high-resolution printers.

Which pieces of the vehicle were 3D printed?

process?

body of the car, bonnet, trunk, doors, headlight assembly, and

There were six car types including the final choice.

when

The size of the car wasn’t an

and needs arise. It also makes sense that once we have nailed

or detailed the subject, the larger the file has to be in order to

issue

the vehicle?

The challenge is always to satisfy the vision of the director

Were there many design iterations?

an

it came time to printing

The car was separated into pieces that were then further digi-

enough to look smooth when printed in 3D. The more organic

size

Prior to 3D printing, how would this have been done?
Originally, we would have used traditional model-making
methods of the past and sculpted clay body parts, then
produced molds for fiberglass.

The body and accessories, such as headlights and so forth.

How many pieces of the car did you have to output?
The car comprises seven 3D printed main parts.

What were some of the overall challenges of building this
particular object?
The overall challenge was first getting everyone involved to
settle on the end look. Once this was done, the next biggest
challenge was meeting the needs of the movie and script.
The car had to fit atop a stripped-down golf buggy [and
accommodate] an actor and a puppeteer. This was achieved

LightWave Magazine Summer 2014 | www.lightwave3d.com
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by laser-scanning the buggy, which enabled us to fit our

What are some of the more unusual props you

LightWave model over the existing chassis data. We then

have created?

scanned one of our staff sitting in the golf buggy so we could
then check for sizing issues and tackle the problem of fitting
the actor in the passenger seat. This process also allowed us to
work out how and where the puppeteer would be positioned.

Try CHRONOSCULPT Software FOR FREE
Fully Functional Features - No Limitations

After being in the film industry as long as Propshop has been,
nothing strikes us as unusual anymore. Creatures, artifacts,
weapons…. It’s all in a day’s work.

The crucial factor is LightWave’s speed, which is a primary
consideration in the film industry. The Modeler is dependable,
with stable, predictable results, and output that other parts of
our pipeline can use. LightWave is also a ‘complete’ package,
which not only generates high-end models, but can be
harnessed to produce polished renders and animations that
are vital to getting work signed off and to expressing ideas.

Which version of LightWave are you using?
We use the current version, 11.6.

This is a functioning vehicle – how did that affect your
design and creation processes?
Almost all our props and hero props have to either function

What type of computer is LightWave running on
at Propshop?

or withstand physical abuse on set. For the car, the body had

We use a combination of 64GB HP Z620 and Z820

to be strong. The body had to fit and bolt onto the existing

workstations, which have proven to be fast and stable under

host chassis. The panels had to function like a real car and be

huge workloads. The HP workstations are fitted with Nvidia

smooth enough to hold an automotive finish. When modeling,

Quadro 4000 and 6000 graphics cards.

we had to be mindful of scale, tolerances, and how it would
be assembled.

At Propshop, what other software do you use?

Did you create any other props for this movie?

We use Maya, ZBrush, Modo, KeyShot, Photoshop, Illustrator,
and many more.

We created a range of other props for the movie, such as
the bust of Ricky Gervais that hides a key. But, my personal
favorite is the CIA versus FBI badge gag. We modeled a
standard CIA and FBI badge from reference photos. These

What does LightWave let you do that other software
does not?

were then scaled up and 3D printed. Sam Eagle pulls out a

All hammers can drive in a nail – I chose the LightWave brand

plaque-size badge to outdo the FBI agent’s regular shield. The

of hammer because it has been around for a long time. It

FBI agent then opens his shirt to display a larger, chest-size

hits the nail straight and works well for me…it’s a proven tool

badge. Sam responds with a six-foot CIA shield to trump the

of choice.

FBI – special delivery LOL.

© 2014 NewTek, Inc. All rights reserved. LightWave 3D is a registered trademark of NewTek, Inc. All other products, brands, trademarks or registered trademarks are the property of their respective owners.

How does LightWave help you to achieve your goals?

FREE

30
S
D A Y S

LightWave 3D

3ds Max

Maya

Softimage

Modo

Cinema 4D

Houdini

Time-Based Cache Sculpting for All 3D Software Pipelines
Sculpt and transform cache animation and dynamic simulation files over time
with this powerful new standalone software for all professional 3D software:
3ds Max, Maya, LightWave 3D, Modo, Cinema 4D, Houdini, Messiah, and more.

Karen Moltenbrey is a longtime award-winning

Which other recent films have you worked on?
We have worked on Maleficent, Guardians of the Galaxy, and

writer and editor in the technology and computer
graphics industry.

are currently working on an epic science-fiction movie.

Time is Finally Relative. www.chronosculpt.com
14
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By Karen Moltenbrey

Revealing “Tim’s Vermeer”

Behind the Scenes

Revealing
“
”
Tim’s Vermeer
LightWave plays a crucial role in uncovering Johannes Vermeer’s secret painting technique

Tim Jenison is many things, but a painter

Vermeer was a painter like no other in

theory, with LightWave 3D at the heart

he is not. While he is involved in compu-

the 1600s. Even today, art critics and

of his experimentation, Jenison just may

ter graphics, his art experience is limited

observers alike marvel and speculate at

have solved this centuries-old puzzle.

to a class from high school. Yet recently,

the Dutch master’s ability to capture his

he was able to paint a masterpiece – in a

subjects in photorealistic detail, creating

manner of speaking. He was putting

a world on canvas that was more perfect

the music les

son
by
ve
r

m
ee
r

a theory to the test, that Johannes Vermeer did in fact use
some kind of instrumentation

when

painting

such

works

as

LightWave Magazine Summer 2014 | www.lightwave3d.com

and later became the subject matter
for the 2013 feature documentary Tim’s

Some believe Vermeer used a camera

Vermeer, which is now available on DVD

obscura (a darkened enclosure with a

and Blu-ray.

lens mounted on the side) to paint his
subjects, which would explain why many

Milkmaid, The Astro-

of his paintings were set within the same

nomer, and The Music

two rooms of his home. However, no

Forming a
Hypothesis

Lesson. And it appears

proof of this has ever been uncovered. A

that Jenison just may

Vermeer’s work focused on domestic

book on the subject piqued the interest

middle-class

of

inventor/

featured a woman performing everyday

art world’s greatest my-

entrepreneur/engineer, who decided to

activities from a small room in his house

steries, using LightWave 3D

look at this debate through a different

in Delft, with many of the same objects

type of lens, literally. After testing his

and decorations present in various

in his processes.

16

documented as they played out live

The

have solved one of the

Tim’s finished painting

than the naked eye can see.

Jenison’s theory and processes were

NewTek’s

founder,

an

Dutch

life
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Behind the Scenes

Revealing “Tim’s Vermeer”

WATCH THE

TRAILER

precisely re-creating the studio

In LightWave, Jenison added a

and no one else really

room the master artist used to

painting to the background in

painted like that because no

paint, as it was laid out in Vermeer’s

Layout, and then worked in the

large back wall usually behind

one else could see it like that.

artwork.

The

software by overlaying the 3D

the subjects who are positioned

Vermeer’s paintings look like

lighting. The objects in the room.

objects on the background image.

near the window in each tableau.

photographs. It seemed he had

But, how does one measure a room

He

figured out a way to paint on top

that no longer exists, let alone

several paintings until all the sizes

of a projection, at least that was

determine how light spilled across

and shapes in 3D meshed with

my hunch.”

it? And, where does a person find

those Vermeer painted. Then he

a 350-year-old harpsichord and

tried to light the images, to see

other 17th century furnishings?

how well the LightWave version

arrangements in each painting.

painted the wall accurately

A large window is situated on
the left side of the room, with a

Jenison is particularly familiar
with

television

lighting,

and

from experience knows that
the human eye is very poor at

For

accurately

people have commented on

discerning

varying

more

than

a

century

gradients on a large, white/

the

beige flat area, like the back wall

Vermeer’s

in Vermeer’s paintings. “It’s like

approximately 200 years prior

video compression. The retina

to the invention of photography.

squeezes a lot of information

Indeed, there was a great deal

down the optic nerve, so you lose

of speculation about the use

a sense of absolute brightness

of a camera obscura, yet there

from

seemed to be a missing step.

the

compression,”

he

explains. Thus, we can determine
variations of light and dark on a
white wall, but we cannot see
them accurately. But, Vermeer
painted it accurately. “He nailed
it every single time he painted
one of these walls, and none
of

his

contemporaries

did.”

That is why Jenison believed
Vermeer may have used some
type of instrumentation to aid in
his painting.
“I was immediately drawn to
the gradient on the wall, which
ranges from very bright against
the windows to very dark against
the far corner,” Jenison recalls
after visiting the Rijksmuseum in
Amsterdam and viewing some of
Vermeer’s work on display there.
But, the variations were more

photographic

quality

paintings,

of

created

dimensions.

repeated

this

process

for

matched the painting as far as

Making a
Prediction
To determine if Vermeer painted
the wall a little too realistically
in his works, Jenison modeled
a few of the paintings using his
company’s LightWave 3D software.

shading was concerned.
According to Jenison, the point to
this exercise was to take a closer
look at the shading on the back
wall, but LightWave – like most
other 3D modeling packages not
tuned specifically for architectural
use – optimizes its lighting model

“I was in the bathtub one day

Although involved in the software’s

and this idea came to me out

development from day one, he

of the blue, that you can paint

had never done any ambitious

on top of a projection, in a

modeling or animation with the

manner of speaking, if you used

program, so the project gave him

a mirror [aside from the camera

an opportunity to learn a good

obscura],” Jenison says. “With the

deal about LightWave and its

extra mirror, you can trace colors

tool set. “I had a cram session on

Simulating

onto shapes – you are basically

LightWave, and I learned the nooks

requires full-on raytracing with

making a photograph.”

and crannies of LightWave that

lots of rays and bounces, and

no one ever sees,” he says. Then

lots of time. “LightWave did not

he began to notice that the same

want to do this. I would turn up

people seemed to appear in the

the number of rays and bounces

artist’s work, a theory he verified

to get an accurate rendering,” he

in LightWave since he now had a

says. So, Jenison began building

complete 3D model of the objects

his own supercomputer with a

and subjects. “I had an accurate

server

model of this woman, and I could

24 cores, “and LightWave just

turn her head to a different angle

pumped along.” A renderfarm of

to see if it matched the person in

50 discarded TriCasters made the

another painting, and found out,

process even faster.

Jenison devised a crude setup
in

his

kitchen

and

tested

his hypothesis – “It worked
amazingly well,” he says. “It was
the first time I ever oil-painted,
and it came out looking like a
photograph.” Intrigued, Jenison
searched

the

Internet

for

similar test results but came up
empty-handed.

apparent in a small reproduction

To prove that his theory did

he saw in a book, attributing his

have merit, Jenison had to paint

background in graphics as the

under the same conditions that

reason he noticed this. “Vermeer

Vermeer did, and that meant

18
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yeah, it did,” Jenison says. “And it
was the same woman in several of
the pictures.”

and simplifies the way shading
works. Simply put, LightWave is not
used to simulate reality, but Jenson
wanted to see if he could get the lighting to match the painting, which
did indeed simulate ultra-reality.
lighting

motherboard

properly

containing

“I needed to know how bright the
[back] wall was at every single
point,” says Jenison.
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Behind the Scenes

Revealing “Tim’s Vermeer”

After nearly eight months, Jenison was

the topic interesting, and together they

harpsichord

able to get enough rays and bounces

decided to make a movie about Jenison’s

provided Jenison with the plans to

to reach a scientific-level image that

quest to solve this 350-year-old mystery.

build one himself; he even reproduced

accurately represented Vermeer’s famed

“With this turn, I had to really do it right.

the ornate block-patterned paper on

room. Facilitating this effort was the

Copying Vermeer’s picture would prove

the top of the instrument. The paper

LightWave team, which he had at his

nothing. I had to build the Vermeer room

on the lower part of the keyboard was

disposal—one programmer in particular

and make it look just like it did in 1650,

unique, but O’Brien had seen it before

even simulated 17th century lenses for

and then I would set up my machine and

on a harpsichord in Paris and made a

his 3D re-creation. Within LightWave, he

try to paint,” says Jenison.

reproduction of that, as well. The viola

northwest-facing window – in effect,
replicating the Delft light. Vermeer’s
room had three large windows, and
Jenison discovered that if he used area
lights within LightWave, he was able to
match the Vermeer lighting – leading

Grant

O’Brien

da gamba came from China. Jenison

was able to set up the sky and angle of
the sun as it came through Vermeer’s

expert

located a similar blue chair in a museum

Preparing for
the Test
Again,

LightWave

proved

in Delft, and modeled it in 3D based on
photographs he took, and then made

invaluable

when it came time to physically build
an accurate re-creation of the Vermeer

them on his CNC milling machine and
lathe, which he modified to cut wood
instead of metal.

room depicted in “The Music Lesson,”

Jenison obtained accurate dimensions

selected because it would be the easiest

from the LightWave scene models to

to replicate and had a large expanse

use in the machine shop for milling the

“I proved I was on the right track and that

of the back wall present. The process

objects. He could determine the size of

Vermeer’s walls [in the paintings] were

was not as difficult as it seems. Thanks

the room and other objects based on

consistent with the laws of physics, but

to Vermeer’s many paintings, there are

the size of the known items, such as

not consistent with the normal behavior

many known factors about the structure

the harpsichord. He then transferred

of our eyeballs,” Jenison says.

of the room and the objects inside. So,

the LightWave files to BobCAD, a CAM

it was just a matter of duplicating the

program,

room and then using an optics machine

so they could be read by the milling

to paint a picture – and see how close it

machine.

him to conclude that the painter likely
had cloth or oil paper over his windows.

Jenison’s preliminary LightWave findings
encouraged him to continue his quest.
“Everything pointed in the right direction
and I had the smoking gun [showing]

comes to the real Vermeer.

where

he

tweaked

them

With the room now ready, Jenison had

that Vermeer was painting physically

The room was subsequently built over

to build the projection device, for which

accurate rooms and his contemporaries

a year’s time in a corner of a NewTek

he crafted 17th century lenses (that were

were not, so he must have had a way

warehouse, with some demolition and

less perfect than they are today). Then,

to trace the colors,” he explains. While

construction required until it was indeed

it was time to put his theory to the test.

a few other artists were employing a

a replica of the Vermeer room.

similar technique, it seems that none
had the same setup as Vermeer – and
the secret died with Vermeer, as there
was no documentation hinting to the use
of a device.

Next, Jenison began searching for the
17th century objects, reproducing many
of them via 21st century methods:
modeling

replicas

within

LightWave

and reproducing them with computer-

This is about the time when this

controlled

experiment got real, or as real as it

regard,

machine

possibly could. In early 2009 over dinner

making various prototypes of NewTek

with his friend Las Vegas Magician Penn

products over the years.) For instance,

Jillette, Jenison relayed his interest in

the Vermeer harpsichord was made by a

Vermeer’s technique. Jillette also found

popular Flemish company, and Scottish

he

has

tools.

(In

experienced

this
from

Music Lesson render

Working with LightWave

20
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Behind the Scenes

Revealing “Tim’s Vermeer”

Testing Phase

In addition to the mirror on the back wall, another small mirror

work, aided by the device, look like Vermeer’s? “It does look

Jenison calls a “comparator mirror” was the key to the painting

like the Vermeer – from a distance,” he says, acknowledging

Jenison quickly points out that he is not a painter, never was, but

process.

that he lacked the artistic skill that Vermeer had. (Perhaps it

has learned how to operate a paintbrush. “I wouldn’t have been
able to paint without the machine even if my life depended on
it,” he says with a laugh. Nevertheless, the device did not make
the process any less complicated.

Jenison explains how it works. “You are now in full daylight
leaning over the canvas, which is flat on a table. Right in front
of you is this little mirror on a stick, and in the mirror you can
see the room out there, and you just have to match the colors

“I naively thought the machine would pretty much make the

and shapes in the mirror. At the edge of the mirror is where you

process automatic, and I would just sit down and paint,” Jenison

do your color matching, since that is where you can see both

says. “It was more complicated than that. There was a lot of

[the projection and your painting] together and can compare the

problem-solving just to figure out how Vermeer did it.”

painting colors to the colors you are trying to replicate. You are
not going pixel by pixel, but rather painting broad shapes and

Getty Images North America

can be compared to a 3D artist using the computer to create
art – the machine aids the process, but the end result is a
reflection of a person’s artistic ability.) Yet, Jenison believes
his painting is more detailed and photographic than the
master’s. “Vermeer would not have been as obsessive as I
was. He would have painted more economically,” he points
out. For instance, whereas Jenison painted every stitch on the
rug, Vermeer painted a few, leaving the impression of cloth.
“In that way he was an artist and I was not.”

Jenison started out with a camera obscura. As he explains,

refining them so they look the same, more like a real artist would

The painting process spanned several months, and during

many assumed that some artists, like Vermeer, went into a dark

do. If you have it perfect, you cannot really see the edge of the

that time, Jenison had the chance to see “The Music Lesson”

room and could see a picture projected on the back wall from

mirror, it becomes invisible. But if one of them [the original or

original, which is owned by the Queen of England and is

a lens installed on another wall, but everything outside the box

yours] suddenly becomes too light or too dark, you can see the

not usually on public display. “I was blown away. I had been

is projected upside down and backward. Again, the projected

edge of the mirror.” There is no subjectivity; it either matches or

looking at prints, and there is far more detail in the painting

Jenison also has since uncovered an artist, Italian Painter

image can be traced but not painted because it is so dark inside.

it doesn’t and the artist has to do more work.

than I had thought,” Jenison says. Another revelation:

Michelangelo Merisi da Caravaggio, who preceded Vermeer

The original is more blue-ish and less colorful than the

by roughly a century and may have used a mirror to match

reproductions, “and that was encouraging, because it looked

colors. “His style was totally different than the artists of

a lot more like I had expected,” he adds.

the time and set the art world on its ear with very accurate

For months, Jenison trekked to his Vermeer room and painted,
tackling a different object each day, though some, like the rug
draped over a table in the foreground, took weeks (about 35
percent of the painting time) because of its intricate pattern.
Moreover, only a small part of the room was visible in the little
mirror, requiring it to be repositioned constantly – a skill in and
of itself, since a half inch in one direction makes the difference
whether something can be seen or not.
Even the paint Jenison used was made to the same specifications
as Vermeer’s, thanks to chemical analysis. Jenison’s background
in television and graphics made the color mixing during the
painting process more intuitive than it would have been for the
average person. “You can spend a lot of time getting the colors
perfect. But, you have to decide when it is good enough and then
Milling a lion head

move on. I regret moving on in certain parts [of the painting]
because I left them in sort of a shabby shape. But I had already
turned this into a huge project and was sick of painting,” he says.

In frustration, Jenison started playing around and held up

“It was drudgery halfway through, especially when I got to the

another mirror on the back wall – and saw this bright version of

rug. But as the rug started to materialize on the canvas, I could

the room. That breakthrough came halfway through the film. “I

tell it was pretty spectacular. Up to that point, no one knew if this

never saw that one coming,” he adds. “I had tried to paint in the

was going to work.”

dark room, but it wasn’t working. That was sort of the low point

lighting on the faces of his subjects. When he died, he had a

Making a Conclusion
So, after years of research and experimentation, what
conclusion did Jenison reach concerning the artist? The
experiment did prove that Vermeer could have painted
this way. “Without any actual proof, it comes down to, what
percentage am I convinced? I am about 90 percent convinced
that he used a setup like mine to paint. There isn’t a note
from Vermeer saying he used a mirror and matched the
colors with the mirror,” says Jenison. But then again, artists of
that period, as now, are mum when it comes to trade secrets.
Since the film was completed, the queen agreed to have
a high-resolution scan made of her painting so Jenison
can continue his research. “There is more evidence of the
use of optics in the original picture than I had seen in the
reproductions,” he says.
Could this experiment have been done without the use of
happened differently. I needed to use LightWave for the

harpsichord, or those little decorations on it. You could tell they

Jenison followed his rule that he would paint exactly what he

using LightWave, it all fell into place.”

were there, but they were really fuzzy.”

saw in the machine as accurately as possible. So, does Jenison’s

how Vermeer painted, but when I got in there, I could not see the
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lot of mirrors in his possession, which is unusual, and would
never let people see him paint,” Jenison explains.
Some of the information Jenison found is in other languages,
and he is having the documents translated. And, he is hoping
his film will lead to others who may have some information
to share about Vermeer that could shed further light on the
subject. In fact, his research garnered nearly 2,400 hours of
material, which was condensed into an 80-minute film. So,
Jenison is considering writing a book, a trip through history
possibly, that would contain new information about the use
of such a device by painters.
“I think Caravaggio used a very simple setup, and for my own
curiosity, I might try to paint a Caravaggio [in much the same
way as the Vermeer],” Jenison says, noting this time he would
not make a movie out of it – “It’s too much work” – but would
probably turn on a camera in case “something interesting
happens.”

LightWave? “It was necessary for me. This could not have

The Analysis

of this project – I had built the room and had this great idea of

Tim Jenison

research and to make the [real] furniture,” says Jenison. “By

Karen Moltenbrey is a longtime award-winning
writer and editor in the technology and computer
graphics industry.
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By Paul Hellard

Sharknado 2

FEATURE STORY

WATCH THE

TRAILER

Chainsaws Up!

When chainsaws, tornadoes, and flying sharks
come together onscreen, it makes for television
magic that leads to a Twitter phenomenon. In
Sharknado 2: The Second One, director Anthony C.

The creative team at

Ferrante goes all in with more action, more actors
and more excitement in an effort to surpass the

The Asylum turn to

huge success of the original Sharknado, which

LightWave to deliver

aired in 2013.

visual effects for the

Behind all the promotion and laughter of

sequel to the Syfy

this entertaining tele-movie, resides a group

Channel’s popular
Sharknado franchise

of experienced creatives at The Asylum in
Burbank, California—all skilled in the art of
generating unique visuals with LightWave 3D. In
fact, they explained that this production would
not have been possible without the use of the
LightWave 3D.
When not juggling tornadoes filled with highflying sharks, Sharknado 2 VFX Supervisor Emile
Smith is working on what could be considered
more

refined

VFX

work—his

production

credits include Serenity, Get Smart, and later on
The Last Airbender and ILM’s foray into animation
in Rango.
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Sharknado 2
as the TurbulenceFD plugin to generate

ractions within that volume in one continuous

the actual Sharknado, which is exactly

element. “It’s not like having multiple voxels

what you might think it is. This was

whirling around together,” remarks Hennes-

a monster tornado, filled with

sy-Barrett. “The whole volume stays as one

amongst other things, hungry

fluid that is continuously calculated. There’s no

angry sharks.”

sharp delineation between one part of a cloud

“It would have been impossible
to do the tornadoes without

or another. It’s like having an electronic cloud
tank that you don’t have to clean.”

TurbulenceFD in LightWave,”

The small crew at The Asylum also used

confirms

Hennessy-

RealFlow and Maxwell Render to help deliver

Barrett. “Hypervoxels are pretty

Mark

some of the heavy water effects. “Other than

cool for a lot of applications, but

that, the whole gamut of the telemovie effects

they just don’t have the ability to

were rendered in LightWave,” adds Emile Smith.

talk to each other the way that fluids
and TurbulenceFD can.” Hennessy-Barrett
has used the plugin for years on productions
such as Fringe, Grimm and Iron Sky. “For
computational fluid dynamics for smoke and

Living the
Challenge

fire, TurbulenceFD in LightWave is a fantastic

The Asylum accepted the Sharknado 2 project

addition to the toolset.” (See Bring on the

because creating a tornado full of sharks was

Turbulence on page 97 for an in-depth tutorial

quite a challenge—they had to look better than

on using Turbulence FD in LightWave 3D to

good, they had to be realistic.

create your own tornadic masterpiece.)

The opening teaser of Sharknado 2 takes place

When the operator activates TurbulenceFD,

on an aeroplane in the middle of a storm. This

they are presented with a volume divided into

presented the challenge of generating “art-

cells. Each of these cells contains information

directable” volumetric clouds so

about the density, velocity, temperature, colli-

could fly through a ‘Sharknado’ before landing

sion data, and pressure, including all the inte-

in New York. “This sequence brought in every

the plane

effect we would use in the film, except for water
surface,” adds Smith. “There was a lot of digital

Bring on the Deadlines

“From the outset, the entire Sharknado 2 project was

double work for the latter part of the film and

challenging but perhaps a little easier than ‘the first one,’”

the volumetrics of the final Sharknado sequence

After all the plates were delivered, the original visual effects

Smith explains, with a wry smile. He quickly adds that this

will entertain for sure. Perhaps some people

schedule for the Sharknado 2 production was to be delivered

was because The Asylum crew was more prepared for the

will even be impressed by how real the VFX

by nine artists over a period of two months. However, after

second one, and they had LightWave to help with render

looks. Of course, if it didn’t look real, it wouldn’t

the movie was sold to screen internationally on the SyFy

times. “For this show, we had Ken Brilliant on the crew a

be funny.”

Network, the visual effects production time was reduced to

few weeks before, building a few really cool shark models,

three weeks for 300 shots. As the third week came to an

and we had Mark Hennessy-Barrett working on R&D for

end, the team fought for and won an additional two weeks

the tornado a few weeks before that three week deadline

to produce and deliver

came in.”

“more polished” versions of the

edit. “Everyone went on overtime and people were working
seven days in the week,” says Emile Smith, VFX supervisor
for Sharknado 2. “When those decisions are made, this is
the result.”
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Placing debris (and the sharks) inside the cloud
formation was where the crew started to have a
lot of fun in LightWave. The creative brief called
for the creation of an animatable 3D tornado.

With the revised deadline looming, the team of artists was

LightWave allowed the animators to animate

increased to 14 and quickly put to work delivering effects

the tornado and then hand it over to Hennes-

with LightWave. “We use LightWave for 99% of everything,”

sy-Barrett for simulation and rendering.

adds Smith. “We used a lot of the new Dynamics tools as well

LightWave Magazine Summer 2014 | www.lightwave3d.com
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Sharknado 2

onstage inside a big green box. “The visuals

Animator Sasha Burrow created several animated sharks that

tell the story of the two occupants climbing

were made to thrash in the air. The MDD Multibaker within

onto the roof of the cab while several sharks

LightWave was used to bake out the vertex deformations of

are swimming around and size them up,” says

all these sharks, which included Great Whites, Hammerheads

Smith. “The multiple elements in the passes and

and many other breeds of sharks. “Random tumbling

layers for this sequence came together quickly

sequences were also written into the script, so the sharks

in LightWave.”

could whirl around the formation after being placed in the

Some of the biggest references used by The

side of the tornado,” explains Hennessy-Barratt.

Asylum for the build and movement of the
sharks, as well as the ocean water, came from
studying the work of digital animation and
effects studio Important Looking Pirates in
Stockholm, Sweden.

Using an NVIDIA GTX Titan graphics card in his workstation,
Hennessy-Barrett was able to generate a complex swirling
tornado in LightWave, which took approximately two hours
to simulate. The frames were rendered in HD in less than 20
minutes per frame.
“This project was on a very tight timeline. LightWave’s
ease of use and really straightforward nature helped The
Asylum crew hit the deadline we were presented with,”

There are two primary parts to modeling the tornado in TurbulenceFD

says Hennessy-Barrett. “Because LightWave is a really

and LightWave—setting up the central emitter, which emits density

forgiving piece of software to use, we were able to break the

into the volume, and creating a rapidly rotating basic cloud. “Since

rules and take immense liberties in the rendering engine

smoke and mist don’t inherently have a lot of inertia, the result was a

to get the job done and out the door. TurbulenceFD is so

spinning core with a sedate haze, which clearly wasn’t enough to make

straight forward, a single artist can use it in LightWave and

a convincing tornado,” says Hennessy-Barrett.

one GPU is usually enough for most tasks,” he explains.
“After that it was quite easy to set those sharks on fire!”

Instead, he surrounded the cylindrical emitter with an extra hollow
cylinder as a collision object and displaced it in LightWave. The outer

Sharknado 2: The Second One debuted internationally on the

rotating cylinder is essentially a drain-pipe containing vapor, much like

SyFy Network July 30, 2014.

a cotton candy machine. To make these cylinders animatable, they
both have a bone chain dropped down the center that is controlled by

Paul Hellard is a writer and editor specializing in the CG

the Spline Guide plugin in LightWave, which ensured the curvature and

and entertainment industries.

tip point of the tornado could be animated. This technique also made
it easy for the animator to grab the emitter and Spline Guide scene to
animate as they pleased before passing the scene to Hennessy-Barrett
to simulate.

Make
Your Own
Flamenado!

Additionally, all the tubular, bone-deformed tornado cylinders were
all built with an Instancer in place. By adding LightWave’s instancing
system to the outer core’s collider object, they could place the previously animated sharks, as instances, into the tornado with a few simple
mouse-clicks.
“We had these tornadoes doing some pretty goofy things,” exclaims

with the Sharks

“The shark on Kon Tiki was completely brilliant, so we totally
used it as a reference because it was really well done,” says
Emile Smith, “and there are hundreds of sharks in this show

Hennessy-Barrett. “One even saunters down Fifth Avenue in New York

In Sharknado 2, there’s a scene where a lone taxi-cab

that are part of the debris within these massive tornadoes.

City full of sharks.”

is stuck on a flooded New York City street surrounded

We used soft body dynamics for a lot of the sharks’ impact

by man-eating sharks. Some of the scene was shot

and particles and instancing in LightWave for the sharks’

on location in New York, while other elements and

interaction with everything on the set.”

environments
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were

completely

Want to create a flaming tornado, also known as a
Flamenado? Mark Hennessy-Barrett has created a
short Flamenado video to show what one actually
looks like and provided the LightWave object and
scene files to download and make your very own.

green-screened
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By Claudia Kienzle

Voyage on “Space Station 76”

Welcome to
Space Station 76
“

in our toolbox, we were able to pro-

FEATURE STORY

WATCH THE

TRAILER

duce visual effects shots with uncom-

”

promised, cinematic quality very fast
and with exceptional creative flexibility.”
As a freelancer, Brooks has also worked
on movie effects for such high-profile
visual effects houses as DreamWorks and
ILM and is credited as the digital artist
that developed the rocket mechan-

Voyage back to the ‘70s in “Space Station 76” where LightWave

isms that made R2D2 fly and walk

and ChronoSculpt come together to help create hundreds of

up stairs in Star Wars Episode II:

visual effects for the new film from Sony Pictures Worldwide

Attack of the Clones, which was
the first time LightWave was used
in production at ILM.

To get to Omega 76—the space station

arboretum, and the main bridge, all of

featured in Space Station 76—go back to

which have picture windows overlooking

the 1970s, then make a hard right into

outer space.

deep space and head for the distant
future. This Sony Pictures Worldwide
feature film offers a sophisticated
view of a space station—traveling
amidst asteroids, ice fields, stars and
floating debris—just as it would have
been envisioned in the 1970s. See
the official Space Station 76 trailer
at Entertainment Weekly online for an

While the initial plan called for using practical models and
miniatures, Brooks suggested to the production team—including
Director Jack Plotnick and Producers Edward Parks and Rachel
Ward among others—that they use CG visual effects instead.

All-in-all, Billy Brooks, visual effects
supervisor and associate producer of

As a proof of concept, Brooks used his iPad to show the

the 93-minute film, estimates that there

producers and directors a CG rendering of a slow moving fly-by

were 35 to 40 major visual effects shots

around a 1970’s style spaceship. To prove that CG animation

along with hundreds of subtle CG effects

was the way to go, Brooks downloaded a free 3D model from

and scene enhancements, primarily

scifimeshes.com, brought it into LightWave, choreographed the

done using LightWave 3D software.

camera movements and created CG lighting that resembled the

He also found the LightWave Group’s

type of set lighting typically used for models and miniatures

ChronoSculpt software invaluable to the

production. When the CG approach received the green light,

inside glimpse of the movie.

visual effects creation process.

It’s in this astral setting that the dramedy

“LightWave and ChronoSculpt enabled us

unfolds into a campy, tongue-in-cheek

to create this movie’s more complicated

soap opera, rich with vintage 70s angst

CG effects with a very, very small crew.

and social tensions. Fortunately, these

Brooks also took the Google Sketch-up designs that the art

Because of the limited resources, we had

adults can search for meaning to

department was using to design the physical sets, converted

to be very resourceful and think outside

their empty lives in Omega 76’s many

the box to solve production problems,”

them to OBJ files and imported them into LightWave. He then

rooms, including living quarters, an

said Brooks. “With these two programs
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Brooks had his former ILM colleague, Production Designer Colie
Wertz, design and build the actual Omega 76 space station
in Maya.

assigned different materials and textures to the illustrations to
assist production designers with building plans, such as evaluating
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Voyage on “Space Station 76”

Instead of spending roughly 300 hours to
perfect a particular visual effects shot, I was
able to do it in just 120 hours. This just saved
me inordinate amounts of time.

different glossy surfaces for the Omega 76’s hallway floors before

“I took HDR images to ensure that I could reproduce the look of

“I used LightWave to create a big metal-framed geodesic dome

based OctaneRender render engine, which works within LightWave

having the painters get to work.

the set and the quality of its lighting. At the same time, I took my

with triangular glass panels. I also used some CG trees [which

as a third-party plugin. “I used LightWave to render out volumetric

iPhone and recorded HD video of each of the computer panels

were free, pre-built models downloaded from Turbosquid.com]

passes, light maps for static interior rooms, and matte passes

with their flashy lights that were located around the bridge,”

and then used LightWave’s Instancing tool to replicate them to give

for use in compositing. I used Octane to render the majority of

Brooks said. “I then stabilized that handheld iPhone footage in

the impression that the arboretum was lush with trees,” Brooks

everything else due to its incredible speed and accuracy. I could

After Effects, cropped it and looped it, and texture mapped it onto

said. “To make this a cohesive space, I added humidity and the

also preview the renders using LightWave’s VPR (Viewport Preview

flat surfaces and simple shapes in LightWave. While the camera

subtle reflection of the trees onto the inside of the windows. So

Renderer), which is a time-saving solution.”

never gets close enough for viewers to scrutinize the images,

if you’re outside looking in, or any other time the camera is facing

the effect—seeing the bridge all lit up from the outside—worked

the arboretum interior, you’re seeing the 3D trees. But when the

The Google Sketch-up designs of the physical sets also served as
base models for recreating those rooms within the CG environment.
When the virtual CG camera would zoom in towards the space
station and peer into one of the picture windows, the interior of that
room would be a CG recreation of the actual physical set. When the
virtual camera panned from the exterior of one room to peer into
the picture window of another room, this transition served as an
establishing shot for a new scene or other storytelling tool.
Much of Brooks’ time was spent creating these interior views from
outside the space station. One such CG interior shot was of the
bridge, which was heavily populated with retro 1970’s refrigeratorsized mainframe computers covered in banks of buttons, dials and
flashy lights. Rather than spending time building a CG replica of
the physical bridge set and its computers, Brooks found a clever
workaround that saved time without compromising the final results.

perfectly for what we needed.”
The arboretum, which is a serene geodesic dome filled
with trees, proved to be one of the more complex visual
effects in the movie. Not only did Brooks have to create
the CG interior view from outside the space station, he
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into space, you’re seeing the reflections of tree images
mapped onto instanced 2D cards and condensation
mapped onto the glass. Without this effect, the shot
wouldn’t look right.”

also created the geodesic dome and many of the trees

Whenever Brooks was on set, he was working on a

in it. These CG elements extended the physical set,

MacBook Pro laptop running LightWave 11.5. But he

designed and built by production designer Seth Reed,

also had a faster, more powerful custom-built Intel

saving greatly on the cost of building out a very complex
physical set.

32

camera is facing the geodesic dome windows and looking out

system at home. His home set-up includes three Titan
video cards to accelerate effects processing and Otoy’s GPU-

Overall, Brooks said, “LightWave enabled him to produce everything
from animatics and effects pre-visualizations to extremely complex
visual effects very quickly and efficiently.” And paired with the
LightWave 3D Group’s new ChronoSculpt software, he adds,
“Instead of spending roughly 300 hours to perfect a particular
visual effects shot, I was able to do it in just 120 hours. This just
saved me inordinate amounts of time.”
ChronoSculpt saves users time when working with animations
and baked dynamic simulation cache files from any application by
allowing you to use sculpting and transformation tools over time.
It allows the deformation or manipulation of eight to 10 million
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Voyage on “Space Station 76”

polygon objects with ease. Users can quickly make creative

simulation is trying to replicate the physical world in the cyber

Alembic data files—of a digital human model that CG

when the space station’s gravity is turned off, water in a coffee

modifications, such as addressing simulation jitter, adjusting

world, finding the right combination of settings for the desired

Supervisor Jason Patnode created for him using Maya—into a

mug begins to rise up and hover mid-air as a big viscous glob

soft body penetrations, and removing stray simulation pieces,

results is like trying to solve a Rubik’s Cube.

file format he wanted to use in LightWave. In terms of sculpting

of floating liquid.

to speed up the processing of complex visual effects.

“Once a huge physics simulation is done, there are seemingly
hundreds of settings to change—such as the weight, size, or
volume of each object—to make a small change to the way the

the damage, Brooks wanted to mar and deface a large metal
object with dents and pockmarks as a massive rock should
sideswipe its surface.

While soft body dynamics enabled the liquid to float like an
amorphous glob, hypervoxels caused little droplets to break
away, and then re-combine in mid-air to form bigger drops.

pieces scatter, if you can find it at all. So it’s kind of a crapshoot

“I brought that LightWave data into ChronoSculpt and then

In all of this, characters on the space station interact with the

basically. You have to try something, re-sim. Try something,

used the brush to just paint on areas that needed to be

water globs, such as a young child sucking the water glob into

In many instances throughout the movie, objects collide with

re-sim. And in that rinse, wash and repeat process, you’ve lost

dented. The damage doesn’t come on instantly. I was able to

her mouth for fun.

each other in space causing debris and fragments to scatter

the goodness that you loved in the background all because

slowly animate dents, dings and pockmarks onto the metal

in all directions. Visual effects like this can be created using

you wanted to get rid of some little piece of debris in the

surface as the rock was moving over it. This lets me see

LightWave Modeler features, such as Fracture and Bullet.

foreground,” Brooks explained.

the effect animate in real-time,” Brooks said. He added that

Fracture predetermines how a solid object will break apart and
how the pieces will scatter when Bullet delivers the force of
impact. These tools produce collision events and destruction
that are consistent with real-world physics and dynamics.
In one particular visual effects shot, where a huge ice fragment
from a comet collides with an asteroid field, Brooks was quite
happy with the chaos that ensued, except for one small piece
of debris that flew towards the virtual camera. Since the

34
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“ChronoSculpt lets you just make the little tweak you want to
your massive physics sim without ruining the parts of it you do
like, giving you more creative control,” Brooks said. “Any effects

ChronoSculpt tools like the brush let him push, pull, squash,
dent, or manipulate object surfaces and shapes interactively,
any way he likes.

artist who’s used ChronoSculpt knows it’s the best thing since

ChronoSculpt essentially extends the robust capabilities

chocolate cake.”

already inherent in LightWave. Among the many powerful

Brooks used ChronoSculpt to do three vital tasks: fix physics
simulations, sculpt damage that was animated, and convert

tools tucked into LightWave’s Modeler are soft body dynamics
simulations and hypervoxels, which worked together to create
the illusion of liquids floating in zero gravity. In one scene,

Space Station 76, which is set for a fall 2014 release, premiered
on March 8, 2014 at the South by Southwest Festival in Austin,
Texas. During the week, it was awarded a Buzz Screening—
meaning it was chosen for a special showing so that anyone
who missed the worldwide premiere could see what “all the
buzz” was about.

Claudia Kienzle is a creative technology writer
whose articles regularly appear in leading U.S. and
international trade magazines.
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Registered LightWave users can save over $300 and get this as an upgrade bundle for $995.

36

LightWave Magazine Summer 2014 | www.lightwave3d.com

© 2014 NewTek, Inc. LightWave is a trademark of NewTek. All rights reserved. All other trademarks are the property of their respective owners.
LightWave Magazine Summer 2014 | www.lightwave3d.com

37

By Karen Moltenbrey

FEATURE STORY

Mob City

WATCH THE

Sunset

Boulevard.

The

TRAILER

name alone can conjure
up visions of Hollywood,
past and present, real and
perceived.

Taking on the Mob,
Old School Style

To

support

Creator/Director

Frank

Darabont’s vision for the TNT
period television series Mob
City, digital artists at Stargate
Studios
3D

to

used

LightWave

re-create

this

famous stretch of road, in
painstaking detail, as it was in
the 1940s.
Stargate Studios’ (The Walking Dead, Grey’s Anatomy,

Stargate Studios relies on LightWave to recreate vintage
Sunset Boulevard for Mob City, paving the way for those
and other effects that are integral to the series.

Parenthood, ER, Haven, Heroes, Dracula, 24) work set
the stage for scenes in Mob City, which is based on
the book LA Noir: The Struggle for the Soul of America’s
Most Seductive City by John Buntin. Like the book, Mob
City focuses on real-life accounts of the gangsters
(including Bugsy Siegel) who roamed the palm treelined streets of a burgeoning Los Angeles and the
LAPD that patrolled those streets.
The project – which required a realistic transformation
of Los Angeles from present day to 1940s – required
a significant amount of digital work. Having had
worked with Stargate previously on The Walking
Dead, Darabont approached the studio to do the
pilot and then the six-episode series that premiered
in early December. Stargate began preliminary R&D
in October followed by production, which spanned
approximately five weeks with a crew of eight.
Stargate was the sole vendor on the series. Its
work entailed some explosions and gunfire, but the
majority involved CG environments – some partial
extensions, others all digital. The crux of the work
was transporting Los Angeles and Sunset Boulevard
back to the 1940s. The lighting department assisted,
giving the series an over-saturated noir look. Just as
important was ensuring that the digital work blended
seamlessly with the live action.

38
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The series’ time period made it difficult for the film crew to
just go on location and shoot. In fact, the first 20 minutes of
the first episode takes place in 1920, and initially the scenes
were shot on location. “Then we realized we couldn’t use
a lot of it because of the modern cars, the people, and the
buildings, which were constructed after that time,” says
Bill Arance, digital artist. “We did a lot of analysis of the
footage, and anything that looked too modern we had to
get out of there.” The artists spent a lot of time cleaning up
the shots, making the city look new, as it was in the 1940s.

A City Reborn in
LightWave

does a great job with environments and vehicles – in

The footage, however, was of the actor sitting on a stool in

the series – either all-CG or with some CG elements – the

fact, with all hard-surface models. And that’s one of the

front of a greenscreen holding a steering wheel fastened to a

most complex by far was Sunset Boulevard, which required

reasons we selected LightWave. It handles those tasks well,”

C-stand. “We had to mold the entire exterior of a 1941 Chevy

a plethora of realistic CG objects within the all-digital set. The

says Arance.

Sports Coupe around him,” says Mike Enriquez, 3D supervisor

to be fully interactive, with vehicle headlights washing over it.
The environment was used in a number of sequences, including

Arance contends that LightWave’s Modeler is the best in the
industry, calling it “fast, efficient, and intuitive.”

at Stargate. Moreover, this nearly all CG shot was bookended
between two live-action ones. And once again, LightWave was
used to drive the scene, particularly to build the car. For the

one where the shot transitioned from a matte painting

“The tools are there, and the workflow is efficient,” says

backdrop, the crew traveled to Beverly Hills and used its circle

augmentation in bright daylight to the nighttime shot panning

Arance. “At the end of the day, the deadline is there but so is

rig to obtain footage in all directions, then camera-tracked the

down Sunset in front of the computer-generated Clover Club.

the model, and it’s the way I promised it.”

original footage of the actor sitting on the stool. They stitched

The software also evokes user confidence. “The confidence

the footage and the 360-degree sphere of the actor driving

I have working in LightWave is second to none. I have no

down the road. After a camera track was done, they applied

problem looking at a client or supervisor and saying, ‘I can get

that to an artificial camera for the background environment.

Minute details sold the realism. And, those details had to
accurately reflect 1940s Los Angeles, down to the manhole
covers, streetlights and cars. “Darabont was specific about the
cars. They had to be exact,” Arance notes.
Some of the vehicles were practical, some came from Stargate’s
expanding digital backlot library, and some were purchased
and then refined by the artists.
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and vehicles – in fact, with all hard-surface models.

Although the artists built several digital environments for

Sunset background spans five to six blocks, and everything had

40

“

LightWave always does a great job with environments

that done in a week,’ or ‘I can get that done by the end of the
business day,’ because I know the software will be there for
me and the tools will not fail,” Arance points out.
Confidence in the software helped the artists tackle an
especially difficult scene that unfolds in the last episode of

When modifying or building the vehicles, the artists used

Mob City. It’s a 180-degree-plus wraparound shot of De-

LightWave 11.6 running on Windows 7. “LightWave always

tective Joe Teague driving his car through Beverly Hills.

All about Time
According to Arance, the director has an eye for film-level
effects, and all the work had to be perfect. And, there was a
lot of digital content. As a result, the eight-person effects team
had to be more efficient than ever to get the work done in just
a few weeks’ time. And, that is where LightWave shined.
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the end result made the struggle worth the
effort. In fact, Stargate’s work on the series
earned the group a Visual Effects Society
(VES) nomination.
Alas, Mob City was not picked up for a new season, which was disappointing to the artists on
the project. Nevertheless, the group is ready
for the next big challenge that comes along,
and without question, LightWave will be part
of it. “The best project will always be the next
one. I do not know what the challenges will be,
but I know LightWave will be up for it as well,”
says Arance.

The LightWave Advantage

For instance, the software’s Compositing Buffer Export Panel

For many in visual effects, including Enriquez and Arance, the

eased the process of breaking down and exporting the render

VPR has been a game-changer. “You are so heavily involved

buffers. “The [Sunset] environment was so heavy and big, and

in a shot when you are working on it, and you can tell if it is

rendering it all at once with the people and cars was just not

chunky while you adjust it in front of you, and that cuts down

going to work,” says Enriquez. Using the feature, the group was

on render times and production times, when you can see that

able to easily select the objects to be included in a pass, and

right in front of you,” says Arance. “That workflow keeps the

even specify what type of pass it would be – diffuse, reflection,

artist zeroed in on his rhythm. You no longer have to wait for a

and so on.

test render only to have the frame finally pop up in front of you,

With other software, when the license goes down, the user is “dead

and find yourself asking, ‘What did I change?’ Just that stumble

in the water.” That is not the case, says Enriquez, with LightWave. “It

alone eats into your day and messes with your flow. Now you

is rock-solid.”

“Being able to break all that out saved us a lot of time from
having to manually set up those passes,” says Enriquez.
“It certainly streamlined the rendering for our compositors.”
Another big timesaver was the Viewport Preview Renderer

can watch your image and manipulate it, and determine if it’s
even worth a test render.”

Without question, being able to see the Sunset environment prior to
rendering was a huge advantage. “LightWave just makes sense. And
we are not worried about it crapping out on us or that we will come
says Arance.

On the occasion when the Stargate crew encounters an issue they
cannot resolve, they call on Rob Powers, president of the LightWave
3D Group. “It is great to have that kind of response and help from a

(VPR) in LightWave, enabling the artists to see a proximate

When the Stargate artists see the imagery sooner, so does the

version of their work before rendering it out. “It was a close

client. And that was important when dealing with someone

match, and that helped us set up our rendering times and fine-

like Darabont, who is specific about what he wants in his

tune our shaders,” says Arance. They were also able to see and

productions. “If you put a nice rendered image in front of him,

interact with the depth-of-field and motion-blur effects within

he can say he needs the street narrower and then concentrate

the VPR. “Turning on motion blur for a shot can quadruple the

on the bigger stuff,” says Enriquez. “The sooner you can give

render time. LightWave can take that in stride,” says Enriquez.

them visual feedback, the sooner you can get straight answers

Although the latest release of LightWave contains powerful

A case in point: He was working on a nighttime lighting rig for

from the client.”

new tools and features, the Stargate artists did not have the

the cars and started to turn on the full radiosity and caustics
in fun, but then he saw the results in the VPR and was “blown
away.” He then got serious, tweaked the features, and used
the result in the bigger shots for Mob City.
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This was particularly important with Mob City, because how
Sunset really looked in this era is different from what most
would envision. It was not easy to make changes once the
imagery was rendered due to its size, says Arance.

original plate

across some random bug that we have no idea what’s causing it,”

Matte Painting & CG Traffic

vendor,” says Arance. “They return your calls and are on the job with
you. Sometimes Rob will even call us and ask if there is something we
need when we are working on a show.” Arance adds, “It’s not just about
the team of artists we have here at Stargate; NewTek is also part of
our team.”

FINISHED COMP

chance to use them for this project. “Most of the shots for
Mob City were not run of the mill, but they did not test any boundaries,
either. There was just a lot of geometry, a lot of content,” Arance says.
The work on Mob City was more complex in terms of scope and
quantity of work than most of the studio’s previous projects. But,

Karen Moltenbrey is a longtime awardwinning writer and editor in the technology
and computer graphics industry.
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Stop-Motion and CGI
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A Whimsical Mix

“

I’ve worked with a lot of people in the
animation community who use different
types of software, and if I tell them I am
going to model and rig something in
one day, they lose their minds. They say,
‘No way!’ But I can with LightWave.

of Stop-Motion & CGI
Creators of “Tumble Leaf,” a new stop-motion series for kids,
enhances rich practical imagery with CGI created in LightWave
3D to deliver a an online first for online retail giant Amazon.

Stop-motion productions have long

One of the more recent stop-motion

The series is the brainchild of Anima-

been known for their charm, with

productions receiving a good deal

tion Director Drew Hodges and Bix

interesting

of attention and acclaim is not a fe-

Pix Entertainment, a Sun Valley, Cali-

ature film but a children’s television

fornia, animation studio primarily fo-

characters

performing

within rich, detailed miniature environments. While CGI has dominated
the animation stage both in theaters
and on television in recent years, the
stop-motion genre has experienced

series. “Tumble Leaf,” a stop-motion
animated series augmented with CGI
created in LightWave 3D and aimed

cused on stop-motion mixed media.
Each episode is 24 minutes long and
airs as a pair of 12-minute stories.

a resurgence of late: In 2009 alone,

at preschoolers, is part of new, ori-

For some time, Hodges, along with

stop-motion features Coraline and

ginal content debuting on Amazon.

Kelli Bixler, executive producer at

Fantastic Mr. Fox gave the 3D film Up

com. The star of the series is a blue

Bix Pix, had been working on a chil-

a competitive chase for the Oscar, as

fox puppet named Fig, who lives on

did Frankenweenie, ParaNorman, and

a large ship grounded on a whimsi-

The Pirates! Band of Misfits in the 2012
hunt against the CG-animated Brave.
While adults certainly have exhibited
a deep appreciation for stop motion,
the style seems to strike a particular

cal island that invites adventure. In
each episode, Fig discovers an object
inside a treasure chest, known as his
“finding place,” and then he and one

dren’s themed stop-motion cartoon
that provided a very tactile feel to the
environments as well as the characters. The main character started out
as Miro, a curious little blue boy, who
later evolved into a fox; the production, characters, and focus then evol-

chord with children, who undoubte-

or two of his friends embark on a

ved into “Tumble Leaf,” and Amazon

dly are drawn to its unique, highly

journey of discovery associated with

green-lit the pilot, then ordered a to-

textured, inviting look.

that item.

tal of 26 episodes that Bix Pix began
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making approximately a year ago. Presently, only six episodes

and testing other software, and you feel like you are fighting

Ikuma eventually became friends with

are available on Amazon, with more to be released soon.

the software when using those other programs,” says Ikuma.

Kokoszka, and they began their foray into

“They claim to do all kinds of things, but they really don’t, or

the world of stop motion as visual effects artists on pro-

things that would have been okay in other stop-motion pro-

it takes a million steps to do one simple thing. With LightWa-

ductions like “Robot Chicken.” When Kokoszka stepped into

ductions – for instance, whereas we might have added stock

ve, it is straightforward, and you can easily find the function

the role of VFX supervisor on “Tumble Leaf,” he asked Ikuma

footage, for this project, we engineered new elements.” To this

you want and are up and running. It can take days to model

to join him. “In other productions, we had to battle the super-

end, LightWave proved especially valuable, enabling Ikuma to

something in other software because they are counterintuitive.”

visor to do CGI because they did not know the capability of the

generate high-quality imagery in very little time.

software we were trying to pitch them [for the CG work],” says

In a typical 12-minute, 100-shot episode, there are five to six

The “Tumble Leaf” characters are puppets, while the sets are
handcrafted with tiny props. Some of the effects are done
in-camera, while others are added digitally under the supervision of Brian Kokoszka and generated in LightWave by Lead
VFX Artist John Ikuma. Perhaps surprisingly, there is quite a

their A game. “We were working at a high level of detail and
precision,” says Ikuma. “A lot of times we added and fixed

bit of digital work on a stop-motion production, and “Tumble

As much as he loves visual effects, Ikuma is equally enamo-

Leaf” is no exception. There is a lot of cleanup work, such as

red with the art of stop motion. “I grew up with Gumby and

Ikuma. “Then I got this call from Kokoszka who said, ‘I got a

VFX shots that require CGI work, each ranging from a few se-

removing rigs, light flickers, set bumps, camera dust, and holes

had a love for stop motion from an early age. I was obsessed,

gnarly shot and if you can knock it out, we will bring you in as

conds to 12 seconds or longer. The formula for determining

in the characters’ hands and feet – all done by the visual ef-

and years later founded Stop Motion Magazine because the-

the VFX lead.’” The shot was extremely complex, with motion

what becomes CGI is simple. If it can be done, and done within

fects team. In addition, the group adds effects that are impos-

re were no resources to educate artists about stop motion,”

control and dandelions exploding and blowing into the air. He

the allotted timeframe, stop motion is used. Otherwise, it is

sible to capture practically, such as shimmering water, floating

he says.

nailed it and joined the production last September.

CGI. “CGI adds those extra elements and does the impossible,

Ikuma was neither formally trained in stop motion nor compu-

A crew of approximately 100 handles the production of “Tum-

ter graphics. Rather, he began professionally as a compositor,

ble Leaf,” and among them are up to a dozen visual effects ar-

working on commercials and music videos as a producer, di-

tists. The CG elements, though, are mainly Ikuma’s responsibi-

Working as a digital artist on a stop-motion production can be

rector, and artist for more than a decade. “Working on those

lity – he creates the majority used in the show with LightWave.

more difficult than working on live action, Ikuma points out.

bubbles, skies, and more. Lastly, the department is tasked
with color correction and fixing dissimilarities in the lighting
on the stages and the slight inconsistencies in the characters
and props, as multiple puppets, objects, and sets are used in
a single episode.

projects, you have to educate yourself in many areas because

An Amazon Adventure

yet still makes [the imagery] look like it fits into the stop-motion world,” explains Ikuma.

For example, stop-motion animation cannot be changed once
it is done; it can only be cleaned up. “It’s one take and you are

The demands of a stop-motion production with VFX are more

you are working with a small crew,” he explains. “If I was the

similar than not to those of live-action television, a genre

guy, I had to learn stop motion or computer graphics because

where LightWave has proven itself as a go-to software pro-

no one wanted to do it or their prices were too high for the

Because “Tumble Leaf” is one of Amazon’s first children’s pro-

explains. Also, with a stop-motion shot, there are a number of

gram. “LightWave has been a godsend. I have spent years using

budget we had. So, I was self-taught.”

ductions, it was imperative that Bix Pix and the artists bring

rigs that hold up the puppet or make them jump, “and the fox
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Ikuma provides another recent example during which he
used the Hair system to create a thousand fluffy, white
dandelion seeds floating in the wind. Each seedpod had ten
thousand “hairs” on the stem. “To make the close-ups look
good, I used an Array function within Modeler to make an
array on the object and extrude it,” the artist explains, noting that he uses all the basic features within the LightWave
Modeler when working on “Tumble Leaf.” “Modeler is one of
those things that is simple but more than enough to enable
us to do what we have to for the production. The UV texturing is brilliant for unwrapping and rewrapping things.”
In terms of rigging, the tools are fast and flexible, the CG
artist says. “And the Skelegon function within LightWave is
super fast,” he adds. (Skelegons are bones that are set up in
Modeler and can be animated in Modeler or Layout.) “The
weighting system is extremely easy to use and understand.
Most of the time I am not worried about modeling and rigging something and getting it out [when needed]. It is just
that fast.”
Even though the main cast in “Tumble Leaf” comprises pup-

loves to jump and flip,” he adds. “We have to clean the shots,

are instances, however, when he will start with a polygon or

pets, Ikuma nevertheless had to build accurate (but not pho-

build and bring in the elements, animate it, light it, texture it….

curve and then use the Lathe tool in Modeler for faster results.

toreal) CG versions of Fig and his friend Maple to act as in-

Whatever else needs to be done, we do it. Then we comp it.”

Ikuma is often called on to create and animate butterflies, and

Ikuma always finds himself having to matchmove shots and

not just one. In this type of situation, he must determine what

then comp the CG elements into the shot. Using Pixel Farm’s

the director and stop-motion animator are thinking, and how

PFMatchit and PFTrack, he matchmoves and camera-tracks the

to best approach the shot. Using the VPR (Viewport Preview

shot, then brings the camera elements into his scene within
LightWave, where he builds objects based on whatever the
puppet or set department has determined the scene needs.

visible collision objects that would interact with the varying
dynamic effects in LightWave. “I had to rig them, get them
into the scene, and start animating them – and had five
days to get four shots out that required the characters to
have interaction with fluid dynamics,” he recalls. So he box

Renderer), he can show them a preview of his animation and

modeled the characters as fast as he could with the refe-

make changes right there. “It’s spectacular,” he says of the VPR

rence he was given, and then he rigged the characters with

capability. “If the visual effects supervisor or director wants

Skelegons, saved them, and sent them to Layout, where he

any changes, I can correct them on the fly while they are sitting

converted the Skelegons to Skeletons and animated them.

next to me. It is an extremely fast process.”

“It was straightforward, simple, and easy to understand

One episode called for 20 to 30 butterflies in a shot. Ikuma

what each step required. You just build it, animate it, put

All the CG modeling, rigging, animating, and texturing by Ikuma

started with the previsualized element the puppet departme-

an emitter on it, and then tweak your emitters to deal with

is done within LightWave. He uses the latest version (11.6 as

nt designed and brought it into Modeler, and using the box

particle reaction. It was brilliant,” he says. For the smoke

of this writing) and faithfully updates the software when a new

modeling process, created a butterfly. He then unwrapped

and dust effects in this shot and others, he used a plug-in

release comes out. At Bix Pix, the software runs on “bare-bo-

and re-wrapped the UVs, rigged it, and animated it. Next, he

called TurbulenceFD, a particle fluid dynamics emitter for

nes” iMacs with NVIDIA cards, but output has been slow, so
Ikuma prefers to use a 2006 maxed-out Mac Pro 1.1 with Intel
Xeon processors – which has a fast refresh rate “that lets me

brought the elements and approximately six versions of the
model into Layout “and mashed it altogether.” When it came

LightWave. “There were times when I wouldn’t have been
able to do the production without it,” he says.

time to set the virtual camera, the process was simplified thanks

While LightWave offers procedural and nodal animation

to the presets in LightWave that enabled him to select the ca-

tools, the artist prefers to use procedural animation since

Ikuma does a good deal of point modeling with boxes for

mera (here, a Canon Eos 60D) and lens, along with the focal di-

it is fast and easy to use, but relies on the node base editor

“Tumble Leaf,” whereby he starts with a square and moves

stance, used by the camera department, and match it up within

for texturing. According to Ikuma, he animates on the fly:

around all the planes until he gets the shape he wants. There

the software.

“I keyframe the model animation while using the referen-

see what I am working on.”
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BEHIND

THE

SCENES

“I will model a leaf, maybe four or five, and

pricing. “With stop motion, we are dealing

Could Bix Pix have produced a show of

set my path or goal in the Flocking system,

with low budgets for the CGI since we deal

this caliber without using CGI for the ef-

then generate a ton of little leaves, and

mainly with practical objects, and most of

fects? No, maintains Ikuma. Could it have

they will blow across the screen,” explains

us have to buy our own software. It makes

been done with another 3D program?

Ikuma. “It’s very fast compared to anima-

a huge difference when we own the

ting each leaf by hand, which I have had to

software, and The LightWave 3D Group

do for a few specific shots. I make a lot of

understands that.”

leaf elements.”

Yes, in theory, but the process would
have taken far longer, he notes. And who
knows if the results would have been the

In fact, before investing in the software,

same. One thing is certain, the results

The Flocking system can be used with

Ikuma looked at the manufacturer, The

obtained with LightWave have helped

LightWave’s Instancing system or Hyper-

LightWave 3D Group, a Division of NewTek,

Bix Pix achieve a superior aesthetic for

Voxels. “With Instancing and the Hyper-

Inc. and was comfortable with its agenda

“Tumble Leaf,” which was recently reco-

Voxel particles, I cannot say how brillian-

and the fact that it is not a huge company

gnized with the Jury Award at the Annecy

tly easy and simple it is for me to have

based in another country. “The company

hard-body and soft-body dynamics,” says

works closely with the artists, and if I

Ikuma. Instancing allows for vast duplica-

e-mail them, I have a response within the

tion of objects in a scene with little expen-

hour or, at the very least, that day. With

se, while HyperVoxels enable the creation

others, I have to wait a few days,” he says.

of volumetric effects such as smoke and

“You fall in love with the software, but you

liquid. The use of HyperVoxels was cru-

are also committing to the company, and

cial in a scene where Stick, Fig’s caterpillar

I am comfortable with my investment in

friend, pretends he is a wizard and casts

LightWave and The LightWave 3D Group.”

International Film Festival for a TV series.

the dandelion seeds from his wand. “I
could have used various options but dece footage provided by the offline edit,

of the time. For the other .1 percent of

and fine-tune it using the graph editor

the time, he uses ZBrush because he can

within Layout – it’s straightforward and

paint on the texture. “With the GoZ fun-

easy. Everything is labeled properly and

ction, I can connect flawlessly between

there are no hieroglyphs that you have

[LightWave and ZBrush] and communica-

to figure out to determine what tool you

te and exchange model and texture data

are using, as there are in many other

easily without any errors. And if I need

software programs.”

to, I can make adjustments in real time,”

“I’ve worked with a lot of people in the
animation community who use diffe-

he adds.

cided on a HyperVoxel particle emitter

with LightWave
“Tumble Leaf” gets it name from the
natural environment in which the show
is set. And, yes, there is a red leaf that
tumbles around at the start and end of
an episode to support the moniker. “The
characters and creatures are exploring

The DP sets the lighting for the series, and

and interacting with the environment

Ikuma matches it in CG using a number

around them, which includes leaves and

of area lights, starting with a three-po-

dandelions,” says Ikuma. “Some scenes

int light system. He adds spotlights with

call for many, many particles. Somethi-

gobos, matching the DP’s time of day,

ng is always whisking by the camera to

color saturation, and so forth. “Here you

LightWave also offers a nodal system and

rent types of software, and if I tell them

and made Instances, which took about an
hour,” the artist recalls.
Specifically, Ikuma used ParticleFX, a particle engine within LightWave that works
with HyperVoxels. He used gravity, wind,
and collision to make the objects bounce
around and off one another and interact
with the wind. “There is a scene where the
characters are on the ship and particles fly
around behind them, and we had to use

Head-On
While Ikuma faces many challenges while working on “Tumble Leaf,” the biggest one pertains to the hardware, the
Achilles’ heel of many productions. “The
software does exactly what it is supposed to,” he adds. “The hardware is often
counterintuitive and you end up fighting
it the whole time.”

the wind function to push the particles,”

Nevertheless, the rendered CG for the

he notes. Another time it was used to

Perhaps the highest praise of all comes

series enhances the richness of the prac-

blow flower petals and even a flour dust

tical sets and fits naturally in the stop-

from the preschoolers who have embra-

cloud. “There’s always something blowing

keep things interesting for the viewers,

motion world. “This is probably the most

around,” he adds. While Ikuma has high

are using a ton of smaller power lights to

who are little kids, so there are a lot of

detailed stop-motion television show for

praise for the many LightWave features

kids in terms of lights, textures, and color

layer-based system for surfacing, and

simulate the exterior of a scene. In live ac-

dynamics, as well.” As a result, Ikuma

and tools, he cannot be more pleased with

that’s been made in the past 20 years,”

tion, you can use the sun to balance it out,

uses the Flocking system frequently,

award-winning

the two can be mixed together. Again,

the fact that he owns the software license,

maintains Ikuma. “It has a superior ae-

Ikuma prefers the faster layered system.

but with stop motion, it is a more control-

in which the Flock controller calculates

which he says makes it more affordable

editor in the technology and

sthetic. These stop-motions sets are

While he uses Photoshop for color, he

led environment and is indoors, so you

crowd avoidance of nearby objects for

for individual artists to use, as opposed

works of art. And the CGI has to match

UV maps within LightWave 99.9 percent

have to be sure to avoid flicker,” he adds.

realistic motions of many objects.

to renting the program via subscription

that aesthetic perfectly.”

I am going to model and rig something
in one day, they lose their minds,” says
Ikuma. “They say, ‘No way!’ But I can
with LightWave.”
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ced Fig and friends, and all the adventure
and learning that “Tumble Leaf” offers.
Karen Moltenbrey is a longtime
writer

and

computer graphics industry.
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WATCH THE

TRAILER
Everyone knows the story
of “Tom Thumb,” right? Not

tOM Little
and the
Magic Mirror

necessarily. Ask the youth
of today about the famous
fairytale and chances are
you will get a blank stare. Or
they just might let you know
they saw it on a podcast or
YouTube video on their cell
phone or iPad.
The nature of storytelling
continues to evolve, which is exactly why Director and
Screenwriter Ernesto Padrón of the Cuban Film Tom
Little and the Magic Mirror decided to retell the story of
“Tom Thumb in 3D; the project was backed by the film
studio Ficción Producciones and the FX ANIMATION
3D Academy in Barcelona, Spain.
Widely recognized as a hugely successful animated
movie, Tom Little is the first 3D film of Cuban origin.
It premiered in cinemas across Cuba on July 20, 2014,
receiving positive feedback from viewers young and
old, which translated into long queues and healthy
ticket sales.
The film tells the story of Juan, also known as Tom
Little, a young and tiny member of a poor peasant family. During the course of the story, Juan experiences
many adventures as he tries to end his family’s poverty, save an enchanted kingdom, and capture the heart
of a beautiful princess.

Students at FX Animation in Barcelona collaborate with
Cuban filmmakers to recreate well-known fairytale for the
21st century using LightWave 3D.

Creating CuttingEdge Production
Ficción Producciones, a production studio based in
Galicia, Spain, produced the 3D animated film, which
was directed by Julio Casal and Mamen Quintas. “The
Cuban-Galician coproduction is the result of trip to
the Film International Habana Festival at an invitation of the Animation Studios from the Instituto Cubano del Arte e Industria Cinematográficos (ICAIC)”,
explains Casal. “My partner Mamen [Quintas] met
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the project through Esther Hirzel (ICAIC), who presented the production difficulties to us and we decided to participate in it. There
have been more than 250 people working on the project and its
Without a doubt, the technical work

management was very complex, nearly epic.”

of Tom Little marks a before and an
The extreme distance between studios and the near absence of In-

after for the Cuban film industry

ternet in Cuba, forced the team to travel much more than expec-

as the first film made entirely in 3D

ted. Ultimately, they decided to have a person stay permanently in

but also for the great work in the

Cuba to help maintain the continuous learning process. “Nearly

technical delivery of the film, which

everything was made simultaneously in Spain and Cuba. We worked

include:

internally with Shotgun but because there is a lack of Internet, had to

aspect at Ficción Producciones; Victor

do extra work with a great effort from Ariel, ICAIC Head of Production,”

Galdón, LightWave Artist at Ficción

says Casal. Tom Little will be distributed in more than 10 countries.

Producciones;

Bruno

López,

and

technical

Xavier

Planas

former student of FX Animation and
member of the film’s technical team.
Casal saw in LightWave the solution to his

faster

challenges, however he faced a potential problem:

explains Villa.

the initial 3D tests for the movie were created

“We

in Maya. This forced Casal to assess whether it
was viable to transfer the product from Maya to
LightWave. The Galician producers suggested
Casal test the transfer to a LightWave pipeline
with the team at FX ANIMATION, “We were given a
scene from the film created in Maya experiencing
serious issues to be rendered, if we managed to
transfer it to LightWave and render it, he would
then change his pipeline from Maya to LightWave,”
explains Villa.

and

also

with

worked

better

quality,”

internally

with

Shotgun and Fusión, which allowed
us to finish a tailor made pipeline—
the

project’s

needs

were

met

López: I have been technical director/

companies,” remarks Casel.

TD Head, starring director, and film su-

After the venture between Ficción

Galdón: I was there to support the

third part of this 3D technical puzzle

team at its inception in the use of

remains: the Animation Studios of the

LightWave for the production and as a

Instituto Cubano del Arte e Industria

VFX technician.

Cinematográficos (ICAIC), responsible
for making the characters in Tom Little

and FX Animation was able to successfully transfer

look alive and evoke emotion from the

the Maya scene into LightWave, maintaining

audience in a single glance. The ICAIC

camera and character animations as well as

studios were founded in 1960 and are

textures. Next, the scene was lightened according

devoted to the promotion of cinema

to the references and rendered in LightWave in 15

in Cuba. It has a systematic role of

about LightWave software. After showing him a product demo,

minutes—with more quality than was expected.

exchange with other cinematographic

he was surprised by the software’s rendering quality, speed,

Moving forward, Ficción Producciones changed

To change the magic and classic scenario of Pulgarcito into

and ease of use. Following the demo, he told me that he was

its pipeline and FX Animation trained its technical

an animated 3D world, Ficción Producciones counted on

looking for an alternative to Maya and mental ray software for

team in LightWave 3D, offering

the support and collaboration of FX Animation Barcelona

the the 3D production pipeline for a project he was working

necessary support they needed during the first

3D School, which has been specializing in 3D and animation

on,” says Villas. “He needed to sort out the lighting, shading

year of production. “It was curious to notice that

for close to seven years. Xes Vilà, technical director at FX

and rendering as well as finish certain environments, fix a

before the LightWave training started, the staff

Animation, explains how he first met Julio Casal: “I was at the

multitude of problems in VFX, and above all, complete 100% of

was not keen on it. However, after only two days

Broadcast Fair in Madrid, making LightWave demos in the

the shading, lighting and rendering.”

of training, they were all convinced that LightWave
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would allow them to carry out the production

pervisor for various processes.

Producciones and FX Animation, the

support and data exchange with other 3D software

NewTek booth, when Julio [Casal] approached me and asked

technical team?

and I recommend them to other

Luckily, LightWave 11 offers powerful format

them the

What has been your role within the

Planas: I worked on the 3D lighting
and the pre-composition of the sets.
During the last few months of the
project, I also participated in lighting,
rendering and composition tasks.

industries throughout the world,
which allows it to develop

films

with different topics and styles. At
present, the ICAIC studios focus on
the production of a wide range of
films and animated shorts, winning
more than 70 international festival
awards in Espinho, Cannes, Huelva,
New York, and Moscow.
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What are the advantages of changing the
pipeline to LightWave 3D?
López: LightWave allows to condensate all
the processes in the film, which makes it easy
to manage work volume and data to be used
when a co-production of this type is made,
involving two Studios, which are so far away
from each other.

Galdón: It is an economic advantage for
the whole team of CG operators and features
competitive rendering.

What plans or sequences were particularly difficult in
terms of technical realization? How did you resolve them?
López: Directors continuously searched for the most cost-efficient manner to make the sequences or plans. To highlight
any of the plans or sequences, like the ones where outdoor
plants are mixed with water effects, required the machines to
work to their limit. They were solved by using the particles
system in LightWave, rendering management software, data
exchange or total internal access, allowing us to render a great
deal of particles and polygons that surely would have proved
difficult using any different option.

Galdón: The ones including multiple characters with geome-

What LightWave 3D tools would you highlight as essential in this production?

tric cache and those implying fluids. We resolved them with

López: The rendering engine and the possibility of working

the newest tools provided by LightWave from its version 11,

directly and creating a buffer has been essential to the making

which allowed us to use those aspects, that were previously

of this film.

more complex (instances, Renderkit of RF, for example).

Galdón: Instances, Shadermeister, the plugins of Denis

Planas: In the various images, where five or more characters

Pontonnier, and outstanding improvements in the rendering

appear together, we monitored them with lighting to see how

to each scene.

it affected the shades of their skins to avoid flickers in the Final

Planas: In my case, I often used the lights of Denis

Gather cache. Also sets with instanced vegetation that we had

Pontonnier, specifically, the DP Flood Area Light with raytraced

to render, rendered exceptionally with LightWave version 11.5.

soft shadows and a spot cone. I also found other plugins very

We started the project with LightWave 11 which took longer to

helpful, including and excluding lights from the Layout ele-

calculate the instances for radiosity for geometry in the layout.

ments (especially when I had sets with more than 40 lights and

I also worked on a sequence, where there was a flood and, at

many objects to shape or lighten up with filling lights).

the composition level, the water rendering had to be worked

To learn more about FX Animation, visit www.fxanimation.es.
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LWCAD 4.5 is a top set of add-on modeling plug-ins for LightWave 3D. At the core of this software is a
complete set of standard CAD tools, including an advanced Osnap engine, and countless features often found

out to be able to fit it in well with the lighting sets and mask
layers of refraction and specular for detailed fluids.

Images courtesy of: Janus Biela, Martina Margini and Sylvian Saintpere.

in expensive CAD applications. LWCAD 4.5 contains revolutionary features like real-time Boolean curves and
VISIT THEIR

WEBSITE

real-time polygon drilling, which is unique to the industry, and a set of architectural visualization tools that are
special to architectural design. With LWCAD 4.5, LightWave designers can create complex buildings in a
matter of minutes—and push their designs to an entirely new dimension.

WTools3D
w w w. w to o l s 3 d. co m

© WTools3d. All trademarks and the property of their respective owners.
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By Claudia Kienzle

ARTIST SPOTLIGHT

Luís Lopes

VISIT HIS

PORTFOLIO

Describing himself
as a 3D generalist,
Luís Lopes has been
using

LightWave

3D

animation software for close
to 20 years now. And as in any
long-term relationship, he knows
LightWave’s strengths, limitations
how far he can push it and how to get
what he wants from it.
Lopes use LightWave almost daily in his
work for Illusive Studios, a Lisbon-based
agency specializing in branding, product
design, motion graphics and 3D and special
effects for television, film and print. Luis,
who primarily contributes 3D modeling,
texturing, lighting and rendering to these
projects, tends to work independently if
the job is for Portuguese print media but
often collaborates with a team of other
Illusive Studios visual effects professionals
if it’s for TV spots or film work.
While LightWave is not the principal 3D
animation platform in use at Illusive
Studios, it is Lopes’ go-to tool, especially for
3D modeling and rendering. We spoke with
Luis about his use of LightWave and how it
benefits his work.
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Luís Lopes

ARTIST SPOTLIGHT

How does LightWave enable you to get

of friends who were using it, it was the

support for this. With LightWave, I can

projects done faster without quality

most advanced 3D application on the

find a lot of these errors and fix them

compromises?

market, and the Modeler is very good

fast. Since LightWave has so many

for the kind of work I do.

integrated features, most situations

Luis:
Since I’ve been using LightWave for much of
my career, by now I have a pretty good idea
of what I can achieve with it and what the
render times will be. So when a client asks
me if I can deliver what they’re envisioning
for their project, I speak from experience
about what can be done, given their specific
timeframe and budget. LightWave treats my
clients well, even when they’re working with
really small budgets, and it really helps me
finish their projects with amazing results.
A big help in this is LightWave’s Viewport
Preview Renderer (VPR), which gives you the
means to get a good idea of what your final
images will look before you’ve gone through
the time-consuming rendering process. In
minutes, you can send a VPR sneak preview
to your client and get constructive feedback
really fast. So this way, we don’t have to

Also, with this single package, I get a
lot for a very good price. With other
3D applications, you have to pay a lot
of money every year. And since most of
them don’t have good render engines,
you have to pay even more for that

Tell us about your creative process?
Luis:
My creative goal and process are

once and it’s yours. It’s not ‘rented.’

focused on making the client happy.

And you get infinite render nodes with

Ideally, it’s because of my creative

it that you can use with the amazing

input and ingenuity, but oftentimes

render engine.

we’re very limited by the agencies

For anyone just starting out with
LightWave, you may be tempted to
install all the plugins you can find. Don’t
do it. Explore LightWave’s tools first. I
bet there’s one there that already does
what you’re looking for. A lot of plugins
are very specific and you’ll only use
them once in your life.

as to what we can do. Whether I’m
working exclusively within LightWave,
or contributing LightWave elements to
a larger project, my creative workflow
is essentially the same. One creative
principle I have is to keep CG lighting
and radiosity values as close to real
as possible. If you use crazy values for
lights, reflections or shading objects,
you’ll get strange looking renders that

render, or wait until all that effort’s done to

How is LightWave used within

finally get the client’s opinion. Other apps

Illusive Studios projects?

in separate files, it’s faster and easier to

available in LightWave.

capability. With LightWave you pay only

waste time waiting for an animation to fully

don’t offer this. And because objects exist

can be resolved using the tools already

don’t feel natural.

Luis:

update your scenes’ assets when you have

At Illusive Studios

part of your team doing the modeling and

3D applications, including 3DS Max

texturing while others are doing the lighting

and Softimage, for projects where

and rendering.

3D animation plays a starring role.

we use several

LightWave is used for modeling and

What is your LightWave configuration
and why did you choose it?

it

works perfectly well with these

other apps because of its robust
interchange tools.

Luis:
Recently, we had a project that was
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While I’ve been using LightWave daily since

being rendered in another 3D app and it

version 7, I’m now running version 11.6.2

was crashing all the time. A lot of objects

on a Windows system with an i7-2600

had problems and I used LightWave to

@ 3.4 GHz with 16Gb RAM, two Eizo 19-

find and fix these problems. The other

inch screens and a Wacom tablet. I chose

3D apps don’t have the tools necessary

LightWave for many reasons: I had a couple

to fix geometry, or they have very little
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Luís Lopes

I also strive for a natural look with texturing.
I do texturing in a third-party paint program
because I am not a big fan of procedural
texturing. LightWave has a huge library of
procedural textures that I use for masking
or for creating noise. But I’m not

I want to carefully place geometry that needs to be collision-aware, and it’s fast.
I do a lot of print ads for beverages and ice is a must. I can make the ice bits
with fracture and position them with Bullet. That takes less than five minutes
to do. Before these features were added, it used to take the better part of an
afternoon to achieve this, and with worse results.

a fan of using certain patterns

Another big timesaver is the new Assign-Tools feature in Layout, which now lets

to recreate what exists in nature

me avoid the drop-down lists in complex scenes. And then there’s Genoma. In

because I think it’s easy for people to spot

our studio, we have animators, so I don’t get much opportunity to do animation

that it’s a 3D render.

per se. While I love to create characters and pose them, in the past you needed

LightWave has a very good modeler,
especially for polygon modeling. And in
Layout, I love the VPR, using the Node Editor
for surfacing, the instancing system, and
many more features. While some artists
out there may not agree, I find that I work

to be a rocket scientist to make a simple biped rig. Now with Genoma, I can rig
a character in minutes and pose it with minor tweaking in a very short amount
of time. For a long time, I’ve been dreaming of having something like this.

Claudia Kienzle is a creative technology writer whose articles regularly
appear in leading U.S. and international trade magazines.

well within LightWave’s Modeler/Layout
[modular] architecture and view it as a
single workflow.

What LightWave features do you use the
most in your work?
Luis:
LightWave’s render engine has always been
one of its strongest points. I have used other
render engines and I have to say that—with
its power, ease and versatility—LightWave’s
render engine is one of the strongest and
easiest to use out there. And coupled
with the VPR, we can get an idea of what
the final image will look like even faster.
After the LightWave 3D Group merged the
sampling options, it became even simpler
to use. Now a user doesn’t need a degree
in math to tweak it and to understand what
is happening.
With the Instancing tool, it’s really easy
to spread huge amounts of geometry
and render it without any problem. The
distribution could be a bit better because
there’s still some overlapping of geometries
that could be avoided. I also use Bullet when
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By Karen Moltenbrey
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SPOTLIGHTS

College students and new grads turn to social media
to get a jump-start on their professional endeavors

Today’s college-age students grew up
during the meteoric rise of social media,
adept at balancing Facebook posts on
one device and Tweets on another. For
them, information is instantaneous and
meant to be shared – with the world.
In the not-so-distant past, the best
weapon parents had to keep their teens
in line was the threat of grounding, which
usually meant losing driving privileges
for a week or so. Oh, the horror. But
now Generation Y-ers would rather part
with their car than their cell phone or
computer, one survey revealed. Why?
It’s because the devices keep this group
connected to friends, family, society…
the list goes on.

LightWave 3D
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Social media provides Generation Y with a way to hear

back in a face-to-face conversation, particularly with adults;

eb
y

N

o

r
to

Imag

their minds. Many will agree that this group will often hold

a

what others have to say and to let others hear what is on

ch

c
Do

personal connections, and LinkedIn,

Facebook and LinkedIn remain popular

professional use. With Behance, in

along with Twitter and Behance, for

however, when they let their fingers do the speaking, they

professional use, providing students

are anything but timid. This is a particularly welcome trait

and recent graduates (and, of course,

when it comes to Generation Y students using social media

professional artists and animators)
with tools for making contacts in the
industry. Years ago, these folks had

join professional groups and discussions related to their

limited opportunity to meet and connect

area of interest. Most students would be reluctant to

with others – students, teachers, pros,

approach a well-known person in the industry, someone
Imag

like John Knoll or Roger Guyett. But, they would think

eb
y

HR reps. A visiting guest or a lecturer
N

at a conference might have provided
a

an e-mail to the audience. But, what

ch

nothing of Facebooking them or following them on Twitter.

o
c
Do

These college students and recent grads are now focused

r
to

on a career and are using all the building blocks necessary
to further that effort, including using social media as a
professional stepping-stone.

chance did a person have of actually
connecting with that person beyond
possibly a brief, onetime exchange?

particular, he is able to showcase and
share his work and experience with
other professionals, as well as make
“interesting” work contacts.
Fellow FX Animation School student
Roser Falcon also thinks Facebook,
Vimeo, and YouTube are excellent sites
for sharing work. Falcon has always
found employment through personal
recommendations, so it is likely that this
method, albeit through social media,
will net him more jobs in the future.

Today, students and grads make it a

Take a Look

habit to send Facebook and LinkedIn

As mentioned earlier, Generation Y

At one point, the term “social media” pretty much meant

requests, and professionals and others

Facebook. But, that is no longer the case. There’s a

think

these

is a lot of technology at the ready for

plethora of sites out there, depending on a person’s

invitations. Schools even encourage

them to use for this task. Many students

preference for communicating. For those with a lot to

students in this regard. Nowadays, non-

use Facebook for sharing, though

say, a blog gives students/new professionals a forum to

professionals have quite an extensive

video sharing sites, such as Vimeo and

network to aid them in a number of

YouTube, seem ideal for animators

ways, particularly when it comes to

looking for feedback on a project or to

seeking employment.

grab the attention of someone who may

express many ideas and concepts, as well as a chance to

quickly. Social networking sites, such as Myspace, LinkedIn,

Do

N

o

eb
y

opinions and consider opinions and thoughts of others

ch

or
ct

nothing

of

accepting

Such is the case for Nicholas Dease,

Imag

few words, microblogging sites like Twitter let people voice

a

read the opinions of others in the industry. For those of

a first-year MFA student in Digital

loves to share information, and there

help further their career ambitions.
Who knows how many animators have
been “discovered” this way.

Google+ and Facebook, offer the opportunity to build a

Imaging at the Pratt Institute, who uses

network of “friends” for making contacts and following

social networks, social news websites,

Modelers and others may like the

and blogs to help his career building.

mobile photo/video site Instagram,

He uses LinkedIn as his primary social

where they can flaunt their creative

networking site for job opportunities,

side by making a visual statement.

what others are doing in terms of work and projects. Social
bookmarking (Pinterest, Tumblr, Reddit, StumbleUpon) is
growing in popularity, especially in the education realm,

and has found a number of employers

providing an option for knowledge sharing along with a
social platform for interactions and discussion. Instagram
is a popular choice for images and short videos, but

and blogs because it’s imperative that
I remain informed about what’s going

Fa
l

on in the art world,” he says. “If not, I
er

videos that are less than six seconds in length. Whatever

eb
y

s
Ro

you want to keep it short, Vine is a great option for sharing

through it. “I visit social news websites
Imag

n
có

YouTube and Vimeo are better options for longer videos. If

wouldn’t be able to participate in the
culture that’s developing here and

the method, it provides an outlet for posting final work

now. With LinkedIn, I visit to build my

or work in progress and getting helpful feedback. And

connections and endorsements.”

don’t forget about forums on company and non-company
sites, like the LightWave 3D User Community on the
NewTek discussion forum, the LightWave Users Group,
SimplyLightWave, and more.

LightWave Magazine Summer 2014 | www.lightwave3d.com

Be My Friend
social media sites for personal and

to make career-oriented introductions and contacts, and
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student

and visual effects student at the School
for Visual Arts, likes to visit multiple
sites, such as Tumblr and Vimeo, to see
new images, learn new things, and walk
away with new ideas. “I think everyone,
whether you work in the art field or
not, should surround their minds with
as much creativity as possible. There is

Alex Carabi, a former 3D graphics
design/photography

Christina Faraj, a junior computer art

no better inspiration than to admire the

at

work of others,” she says. “Searching

FX Animation School in Barcelona,

these websites helps feed my creative

Spain, prefers to utilize Facebook for

hunger and helps me develop as
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an artist and a person. I like to read and receive

For the past few years, recruiters

However, with the proliferation of

information and advice from other people so I can

have maintained that they use social

the Internet and video tools, many

learn from their experiences and further develop

networking sites to advertise jobs and

experts (and some not-so experts) are

my career and enhance my skills. As a young artist

look for new hires. One recruiter for

posting how-to videos and tutorials on

and college student, I also like to share my personal

a large game development company

numerous sites. YouTube and Vimeo

experiences that someone else may find helpful

swears by social networking, using

are an amateur’s – and even a profes-

and beneficial.”

Facebook,

and

sional’s – hunting ground for tips and

YouTube. Another at a large visual ef-

tricks when it comes to modeling,

fects studio often uses LinkedIn to an-

texturing,

nounce open positions.

compositing, lighting, and a host of

Carabi is actively using Instagram to launch
personal projects, but is still waiting for
results. “In spite of this, I think Instagram is a

LinkedIn,

Twitter,

very interesting tool and will give results in the long

“Social media is giving me connections

term,” he says. “Large companies are showing a big

with other professionals similar to me,

interest in it as well.”

rather than generating work opportunities,” says Carabi. While those oppor-

Jesus Sanz Carasusan, a 3D graphic design/
photography student at FX Animation School, keeps
Facebook as a personal space but finds YouTube
and Vimeo very useful for professional purposes. “I
think it’s an essential tool if you want to get a job to

Hire Me

Vimeo to get them through a particularly
perplexing problem on a project.

tion studios abroad for job estimates,

problems. He also searches forums,

though none have come to fruition yet.

including LightWave forums, to keep

work on social networks, offers for free-

and the latter to share and display work.

and

to YouTube to find answers to a tough

“Since the moment I started sharing my

feedback and possibly pique interest in a project,

artists

– Carabi has been contacted by produc-

and experiences,” he says.

and professional reasons – the former to receive

Countless

animators have turned to YouTube and

Among them is Carabi, who often turns

For Doctor, the opposite has occurred:

Animation School, uses Facebook for both personal

tasks.

animating,

tunities may be sparse, they do exist

be able to show your reel as well as your portfolio

Conversely, Nacho Doctor, a VFX student at FX

other

rigging,

up to date on software releases and
to obtain information on software
functions and features.

lance projects rose exponentially, as did

Falcon and Doctor also use YouTube

word-of-mouth recommendations and

tutorials and Vimeo videos to help

my chances to get into more wingspan

answer modeling, texturing, or other

projects.”

process

Carasusan, however, believes it is dif-

by searching for an answer online in

ficult to get the attention of a potential employer through social media

questions.

Carasusan

is

another who has learned a CG solution
a forum, on a YouTube tutorial, and
so forth. “I will always be grateful to

A huge advantage offered by social media is the

unless you have the right contacts.

those ‘anonymous’ people who share

chance to get friendly with those at studios who

But, he points out, it is even more dif-

knowledge online. YouTube and Vimeo

have some say in the hiring process or know

ficult to get their attention through

are doubtless the best friends of a

someone there who does. In this regard, LinkedIn,

face-to-face contact.

3D artist – beginner or professional,”

Facebook, Reddit, Twitter, and other sites can offer

he says.

the right connections. Go to Twitter and you can

Learning New
Tricks

find a number of VFX studios looking for employees.

to a job interview,” says Nathaniel Peters, a Penn

Not long ago, emerging artists and

Teaching New
Tricks

State student in the school’s Interdisciplinary

animators had few places to turn when

Vendors, including The LightWave 3D

Digital Studio program. “Instead of shopping

they needed to enhance their skills.

Group, have emerged as a particularly

“I think social media is slowly becoming a new path

around a resume, I see it becoming acceptable

Sure, there were (and still are) classes

to try and sell yourself. If you watch the Frontline

offered by facilities such as Digital-

users of their software. On the official

piece ‘Generation Like,’ you’ll see kids – literally

Tutors, online video tutorials from

LightWave 3D Facebook page, visitors

kids – who get sponsorships and free promotional

Lynda.com, for instance, and even

can find sneak peeks at upcoming tools

items because they’re on social media. Today, it has

books by well-known authors in

and features, information regarding

never been easier for someone in a hiring position

the industry, such as Dan Ablan,

content that will get their work noticed,

Jonny Gorden, Timothy Albee, Kevin

a number of LightWave tool tutorials,

to be in direct contact with a potential hire, and be

Phillips, and others.

impressed by their social media presence.”
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interesting and useful LightWave-oriented tutorials

maintains Faraj. “I also feel it’s a great outlet for me

i

eb
y

learn about companies in a more interactive way,”

x

b
ra
Ca

Imag

“Engaging in social media is a great way for me to

Al
e

on YouTube and Vimeo are highlighted.

to market myself and my career ambitions.”

All Good, Almost
Today’s budding professionals have an advantage

In fact, 60 percent of the respondents

social media, particularly Facebook.

say they “compulsively” check their

When they merge their professional

smartphones for e-mails, texts, or

self with their personal self, the

social media updates. And that was

recipe can, at times, be troublesome.

two years ago. Imagine how many

One recruiter at a large VFX facility

more

and

cautions artists not to put anything on

business life through social media

their Facebook sites that they do not

today as more sophisticated hardware

want an interviewer to see, because

devices have made this action even

they probably will. No doubt jobs

easier.

have been won – and lost – due to a

blend

their

personal

Faraj, for one, admits to using social

that generations before them never had, thanks to

media every day. “I use it during my

social media. They are better informed, they can
Imag

obtain information in seconds, and they can reach
millions and millions of people all over the world

downtime or just when I need a break
Je

from work and school,” she says. “It’s

s
s
u

with a few taps on a keyboard. Even those living in

eb
y

a creative outlet for me that helps

person’s social media postings. Some
recruiters

and

college

instructors

advise students and recent grads to
scrub their sites of questionable or
unsuitable material.

nz
Sa

relieve stress, and it helps me grow as

“You have to be very aware of what

with just about anyone.

an artist and a person.”

you are saying online. You need to be

“In this profession, people contact you or give you

Another

remote parts of the planet can make connections

interesting

statistic

from

the Cisco survey: Two-thirds of the

work based on your previous projects; therefore,

respondents say they spend the same

being able to present your work and distribute it

amount of time or more with friends

through social networks is the best face of your

careful and stay professional,” says
one student about to enter his senior
year of college, majoring in Real-time
Interactive Simulation.

professional future,” Doctor says.

online as they do in person. But, is this

To this end, many separate their

a good thing? While this generation

professional and personal profiles.

Falcon agrees, but notes, “Social media helps you

is well versed in using social media

But beware: Easy online searches can

get visibility and promotion, but you have to be

for both personal and business,

locate both personas.

careful not to publish too frequently.”

they run the risk of being extremely

of Generation Y-ers grab their smartphone as soon

eb
y

Connected World Technology Report,” 90 percent

x

bi

Imag

social media seriously. According to a 2012 “Cisco

Al
e

This generation, which matured online, takes

ra
Ca

comfortable communicating behind
the screen but struggle with face-toface interaction and conversation.
number

of

current

the

connections

that people make via social media
will undoubtedly offer the biggest
advantages

they

have

when

students

promoting themself. “Who you know

as they get out of bed (and before getting dressed,

expressed the concern that too much

plays a major factor in your career

eating, and brushing their teeth), with most of them

online conversation can be harmful,

success,” acknowledges the Real-time

checking their social media, along with e-mails and

and that a face-to-face conversation

Interactive Simulation student.

texts, even before they get out of bed. And it does

creates a much stronger bond. Rather,

not stop there. Nearly half of them check their

a combination of the two provides an

social media, e-mail, and text messages during

optimal middle ground.

dinner and other meals.

A

Nevertheless,

Without question, Generation Y likes

“At the heart of the study is the smartphone and

to share a lot. Perhaps too much.

the constant connectivity it provides to work,

And for years, they have done so on

entertainment,

shopping,

and

friends.

Karen Moltenbrey is a longtime
award-winning

writer

and

editor in the technology and
computer graphics industry.

There

are 206 bones in the human body, and the
smartphone should be considered the 207th bone
for Generation Y. They view smartphones as an
appendage to their beings — an indispensible part
of their lives,” the report states.
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LightWave Art Gallery
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LightWave
User Gallery
GENERAL

David Agüero

Cedric Magne - 555lab

Ekho Farkas

Chris Jones

Yosuke Nakamura

David Agüero
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LightWave Art Gallery

Neil Maccormack

Evgeny Terentev

Mauro Corveloni

Naoya Kurisu

Chris Warner

Lorenzo Zitta

Salif N’diaye

Roy K

Steve Mcardle
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LightWave ArchViz Gallery

SPOTLIGHTS

LightWave
User Gallery
AR C HI T E C T URE

Sanguk Jun

Marcello Solferino

Sebastian Smolak

Mitja Bri

Adam Sharp

Martina Magrini
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LightWave ArchViz Gallery

Sebastian Smolak

Paolo Zambrini

Laurent Rouquette

Oscar Anchondo

Marcello Solferino

Paolo Zambrini

Sylvain Saintpere

Eugenio Garcia

Lee Donghyeun
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FEATURE STORY

Looking for plugins for LightWave? We have a database featuring over 975 free and
commercially available third-party plugins for LightWave 3D. Drop in and have a look
around, we are pretty sure there’s something there that you can’t live without. Check
back often for new releases and updates.

Go See for Yourself

www.lightwave3d.com
80
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By Kevin Phillips

Nostalgic Nodes

NOSTALGIC NODES

TUTORIAL

Let’s quickly cover what you can expect to achieve with
DOWNLOAD

CONTENT

this project. The goal is to set up the sprite images to
automatically animate themselves based on how the 3D
model is moving—a similar approach to how it might be

Animating Vintage Game Art with Nodes in LightWave 11.6.3

done in a classic game software.

Then Smashing Them with Bullet Dynamics

You will be using four images for the character—two sprites
and two are black and white mattes. The matte images will
be used to ‘cut out’ the sprite from a grid of blocks.
The general idea is to load all of the sprite animation images
Let’s take an ordinary old 8-bit pixel
sprite image from a favorite vintage
arcade game and recreate it in 3D using
node magic to automatically take care of
animating the sprites. We’ll be bringing
everybody’s favorite game character -

and switch to the image we need based on how the model
is moving. To do this, we’re going to overlap all of the
images and turn them on and off at the right times (yes, it’s
that simple). We’ll then apply these images to our 3D object
for display.

Mario - from the classic Donkey Kong
back to life.
For this project you will need both color
images and a black/white alpha image;
with black pixels (the area we want to
stay visible) and white (the pixels to hide).
In this tutorial, we will be using TrueArt’s
Node Library, a great set of free additional
nodes from plug-in development company
Trueart (www.trueart.pl).
In this project, you will learn how to
build a node system that takes care of
many things. Nodes may seem to be a
black art for many artists, but once you
understand the logic behind the process,

We will use a Mario character, of which there are essentially

it should be much clearer.

only two images— the character standing and the other

Before you start this tutorial, be sure to

images produces the running animation we recognize

install the TrueArt plugins; you use some

from the classic game. When the character is not moving,

of the extended features of these tools to

we see the character standing and there is no running

do some pretty clever things.

animation. Likewise, when the character is jumping we see

walking with legs apart. Rapidly switching between these

the character in stride. Knowing this information will help
animate the images correctly.
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CREATING THE SPRITE IN MODELER

We can use a morph to non-destructively change the shape of
the blocks and then use them to create the UV map. Create

Create a Box. Using the numeric options, create a flat 16x16

a new morph using the M button on the bottom right of the

grid in the Z axis, with a default size of Height 1m, Width 1m,

Modeler interface, then click on the pop-up list where it says

and Depth 0m.

(base) and select (new). Call this morph quickUV and click

1.

Create. Now you can close this window—you won’t need it
onscreen.

2.

Select Mario and scrub to frame 24. Using Move (t), move

the object -3m on the X axis. If “Auto Key : All Channels” is
active (it’s the default) the object should be key framed at 24.
If not, simply press Enter twice to set a key at frame 24.

3.
2.

Click the Create button. Quickly check the UV map by setting

use the Move tool to position the object on the X axis at 3m.

5. Under the Modify tab, activate the Point Normal Move tool

the top left viewport from Top (XZ) to UV Texture. The UV map

Make sure a keyframe has been created at 82 as before (Auto

(found under Translate > More). We are going to use this tool

should consist of a neat set of blocks that are evenly laid out.

Key will have taken care of this if it is on).

These will become our

individual ‘pixels’ for the sprite image.

3.

at the exact same position. Scrub the timeline to frame 82 and

Under the detail tab, use Unweld (CTRL-u) to disconnect

all the polygons from each other.

Use the Extrude tool (SHIFT-e) and using the numeric

options, set the extrude to -62.5mm on the Z axis. (This value

Scrub to frame 34. Press Enter twice to create a keyframe

to shrink the blocks. Open the numeric options, and set the
value for Move to -25mm.

7.

We can now delete the morph and reset the blocks to their

4.

Scrub to frame 100 at the end of the timeline and move the

object back to 0m on the X axis.

is 1/16 of a meter to match the shape of these 3D pixels. As

original sizes (edge to edge). To do this, use the M button at

LightWave allows for mathematical equations to be entered

the bottom right of the Modeler interface, then select Clear

5.

numerically, you can also enter -1/16 to calculate the same

Map (_) under the Map tab.

on the Y axis to 1.5m.

8.

We’re almost done for the simple animation. To finish, open

result.)
Click on the Change Surface button on the bottom of the

Modeler interface (q) and give the mesh a surface name of
mario_sprite. Save the model to disk as mario.lwo and we’ll
move on into Layout to set up textures

Finally scrub to frame 91. At this frame, move the object up

the Graph Editor (CTRL F2) and set some curves to clean up
the movement.

6.

In the channel box, select mario.Position.X. Drag over

all of the keys to select them using the right mouse button,
then change the Incoming Curve to Linear. Next, select the
keyframe at 91 and delete it so the last line is straight.

6.

With the blocks nicely ‘shrunk’, let’s create the UV map.

Using the T button on the bottom right of the Modeler
interface, click on the pop-up list where it says (none) and
select (new). Give the UV map the name UV_Sprite. Set the
Create a UV map for the sprite object to map the sprites

Axis to Z, and click on the Manual button to make the center

onto the blocks we have created. Since we’ll be using 16 x 16

and scale options editable. In the center, set all the values to

pixel images to texture the object, let’s shrink the pixels so they

0m. For the Scale, make sure all the options are set to 1m.

do not sit edge-to-edge in the UV map—we really don’t want

This will ensure the UV map is cleanly laid out to perfectly

the texture image ito bleed into more than one of these blocks.

match the graphic’s pixels.

4.
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Since we will set up our game sprite images to animate with
the movement of the object, it makes sense to have the object
do something specific. Let’s add in some simple animation.
Open the Edit menu > General options panel (o) and set the
frames per second to 24. At the end of the timeline set the
length to 100 frames.

1.

Load your Mario model into a new scene in Layout. It’s will

appear grey, but we’ll address the textures after animation.
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Once selected, click the Add Selected Node(s) button at the top
of the node list. The nodes will be added, but will be on top of

7.

Select the mario.Position.Y channel, and repeat the same

each other; simply left click on each one to drag.

process as above in step 6.
Select the last three keyframes (82,91,100) and change their
Incoming Curves to Bezier Splines. Use the Alt/Opt (Mac) key
and click-drag each Bezier handle of the keyframes until there

Render Info:

is a nice looking curve as seen in the image below.

This node gives us the Frame number the

animation timeline is on. We’ll be using this a lot to control the
way images change during an animation.

Before we begin, click on the small triangle widget on the topleft of the Input node and collapse it. We won’t be using this
node, so closing it just gets it out of the way.

Extended Spot Info: This node lets us grab the Item
ID value that other nodes need when processing information
(in this case it’s the Mario object).

Extended Item Info:

This node lets us ask for

information from an item in a particular frame. It won’t be
used immediately in this animated run cycle, but is essential
for creating the correct images for jumping and standing still in
our system set up. Like the Input node, collapse the Extended
Item Info and Extended Spot Info nodes for now, just to keep

Select all the keyframes before 82 (including 0) and press

them tidy and out of the way until we need them.

delete. Key 82 should be the first, making the curve in front of
it perfectly flat. The reason here is to ensure the object doesn’t

3. Let’s start with a run cycle.

float up or down as it moves. As we’ll see later, the Y motion
will play an important part in the set up—any small change will
prevent things from working properly.

Let’s start by getting the run cycle sequence onto our model.
To do this, we need to know which frame we are on in the

The goal of this project is to set up sprite images onto the 3D

timeline so we can change the pose for each frame in a loop.

‘sprite’ model and animate things as we would for a real game.
One of the great things about LightWave is that it allows for so

2.

many different approaches to achieve the same result.

following nodes (Hold CTRL while clicking on each node):

Unfold the TrueArt’s Node Library > Tools and select the

Extended Item Info, Extended Spot Info, and Render Info (this

ON TO TEXTURING

For this we’re going to need to

add two 2D image nodes—each will hold our two Mario sprite

is not in Tools, but is at the bottom of the list).

images. Under the 2D Textures nodes, double-click twice on
the Image node to add the node to the editor.

4.

Double click on one of the Image nodes and set it to the

standing image. Next, click on the Image drop-down and select
(load Image). Load mario_stand.png. Deactivate Pixel Blending
option (this ensures we’ll get nice crisp pixels without the slight
blur that we otherwise get). Set the Mapping to UV Map, and
the UV Map to UV_Sprite.

At this stage, the free nodes from TrueArt should be installed

Close the node settings,

because you’re going to need them.

marioStand.

press r and rename the node to

This is to make the node system easier to

understand with names that make sense.

1.

Open the surface editor (F5) and make sure the mario_sprite

surface is selected. Activate the button next to the Edit Nodes

To see how this looks, attach the Color output from the image

button and make sure the nodes are active, then click Edit

node to the Color input of the surface node. The texture won’t

Nodes to open the Node Editor.

display in OpenGL, so change the viewport display style to VPR
to see the new Mario character!
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In the node editor, repeat step 4 for the second Image

7. From the Tools nodes (*not* the TrueArt nodes - which also

it’s working great! With the Run cycle done, set up the system

Select the Compound node, and rename it (r). Name this node

node. This time load mario_jump.png and rename the node

has a Tools node set), add a Mixer node. This node lets us

to use a standing image when the model is not moving, or a

“check if it moves”—it will be used to calculate the amount of

mix two color inputs (in this case our two images) using an

jump image when the model is moving up and down. Our

movement the character has between frames, and will then

opacity value.

character is already animated, so we should be able to see the

create a simple vector to control the other two poses.

5.

to marioJump.

effect of the new functionality when we play.

2.

Connect the marioStand node Color output with the Mixer

We need to specify inputs for this node—and need the

Bg Color input. Follow by connecting the marioJump node

At this stage, it’s a good idea to consider saving your object and

current frame and the object ID. Click on the Frame output

with the mixer’s Fg Color input. To animate between the two

scene (if you haven’t already). The textures are stored with the

of the Render Info node and connect it to the new input on

images during the animation, attach the Mod nodes Result

object, so make sure to save both—not just the scene!

the Compound Node. Next, click on the Item output of the
Extended Spot Info node and connect it to the second new

output to the Opacity input on the Mixer.

MOVING ON

input that appears on the compound node.

When the object is not moving, we don’t want to play the run
cycle, use a static image instead. This requires a little logic to
determine whether or not the object has stopped moving but
you can use it to force a single frame to be used instead of

Like the video game, we want to make these images animate

an animated run. This may seem a little complex, but thanks

as our character moves. To do this, we will switch images

to the TrueArt nodes we can analyze the movement of the

every other frame. The easiest way to do this is to use a small

object—the result controls another mixer node that switches

mathematical function called Mod. Mod is short for modulus,

between the static and the animated images.

and returns a remainder value after calculating how many
times a value can be divided by another.

Press TAB to unhide the Node Editor and let’s get the still
(standing) image to work. We know that the character in the

Since we will be working with two animated images, we just
need to work out the frame number and Mod by two. If the
frame can be perfectly divided by 2, this will return a 0. Odd
frames cannot be perfectly divided by 2, so mod will return a 1.
We can use the constant 0,1,0,1 sequence as a switch to easily
select which image to use.

6.

animation does not move between frames 24 and 34, therefore
Now, connect the Color output of the mixer node to the Color

this is where the running animation should stop.

input on the surface and that’s all for for the run cycle. As the
animation plays, the two images will be switched at even and

1.

odd frames.

Now that we have all these nodes floating about onscreen

Uncollapse the Extended info and Extended Spot info.

you will see that things are starting to look busy. So let’s put

Add a Math > Scalar > Mod node. From the Render Info

node, connect the Frame output to the A input on the Mod
node. Double click on the Mod node, and set the B value to 2.

3.

Select the Extended Item Info node and cut it (CTRL x).

Double click on the Compound node to open it—you will see
a blank Node Editor window, but don’t panic! We are now
creating a node network within this Compound node, which
will be doing all of the calculations for us. You will see that
a Compound node has Input and Output nodes—we will use
these to set up what connects to the node, and what the node
will send out after the information has been processed.

the Compound Node in LightWave to use. Add this node

If we uncollapse the Input node, we should see that two inputs

from the Tools section by double-clicking on the Compound

we created. Now paste (CTRL v) the Extended Item Info node

Node option.

twice to create two new nodes.

Lets hide the node editor (press TAB to hide the windows)
and scrub through the timeline with VPR active to see the
animation. While obviously there are some things that are not
quite working here, the animated graphics sequence looks like
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The difference between two frames can be calculated by

6.

Finally, connect the Result output from the Subtract node

8.

The outputs are both called Color, so we’ll need to make

simply subtracting the Position of an item in one frame from its

to the new input on the Output node…and we’re finished. Exit

them easier to identify. To edit each output’s name, place your

Position in the previous frame. Let’s connect the Frame input

the Compound node by simply double-clicking on either the

mouse pointer over the name of an Output and right-click.

to the Frame input in one of our Extended Item Info nodes.

input or output node. This will take us back to the main node

Select the pop-up menu Node Menu > Rename Input (Color)

network. With this compound node, we have created a re-

option (the top one). Call it “Stand” (make sure you are naming

usable node to calculate the movement we need to control the

the input for the standing image). Do the same again and call

last two sprite poses, which is very handy indeed!

the other Color output “Jump.”

From the Math nodes, add Scalar > Subtract node. Then attach
the Frame input to the input A of the Subtract node, double
click on the subtract node, and change the B value to -1. This
will calculate the previous frame number. Next, connect the

Double check the images are connected to the correctly named

Result output from the Subtract node to the Frame input of the

outputs and double-click on the Output node to exit.

second Extended Item Info node.

Reconnect these two outputs to the Bg and Fg Color inputs of
the Mixer node. Rename the Compound node to Mario Sprites

2.

to make it easier to identify. Doing this will create a simple

from the Surface node, and attach it to the new Mixer node’s Bg

node for the set of images and will keep it looking tidy.

Color input. Attach the Stand output from the Mario Sprites

Add another Tools > Mixer node, disconnect the Color input

compound node to the Fg Color input of the mixer node. Next,
connect the Out from the Logic node to the Opacity input.

7. Let’s set up the standing pose. To do this, make sure the
movement on X is 0 (ie. its stopped) and use it to control
Connect the Item output from the Input node to the Item inputs

another Mixer node that blends a static image over the top of

of both Extended Info Nodes—this value contains the Item ID

the run cycle.

of the current object that the nodes are applied to, which in
turn ensures that the Extended Info Nodes know what item to

In the Node Editor there are two Mario images—we will be

retrieve information for.

using these a few more times so let’s just tidy things up by
placing the two nodes into another Compound node. Start by

5.

From the Math nodes, add a Vector > Subtract node. Connect

selecting and cutting (CTRL x) both of the image nodes. Add a

the Position output from the first Extended Item Node to the A

new Compound node, double-click on it, and paste the image

1.

input on the Vector subtract node that we added. Repeat this

nodes (CTRL v). Connect the Color outputs of the two Image

is animated moving on the X axis, so let’s add a Tools > Vector

process with the other Extended Item Info node, and attach it

nodes onto the new ouputs of the Compound node.

Scalar node. Attach the “check if it moves” node’s Result output

to the B input.

Now let’s get the Stand still image working. The character

Let’s test this by attaching the Mixers Color output back to the
Surface nodes Color input. Hide (TAB) the Node editor and
play to see it stop animating between frames 24 to 34.

to this node’s Vector input. Double click on the Vector Scalar
node and select X Channel from the Mode drop-down list.
From the Math nodes, add the Scalar > Logic node and attach

Save your scene again!

the Scalar output from the Vector Scalar node to the A input on

We’re almost done! All we need to do is repeat the same

the Logic node. Double click on the Logic node, and set the B

steps above that we did for Standing still, but with these small

value to 0. Next, set the Operation to “A Equal to B” and leave

differences:

the If True/If False values as the defaults.
A Logic node will let us test to see if the X axis is moving. If it’s 0
(not moving), it will return a 1.0 value (or what is regarded 100%
in most LW functions).
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Connect the “check if it moves” Result output to A, and change
the Operation to “A Not Equal To B.” If the Y move is not 0, the
character will be jumping.

TROUBLE SHOOTING TIP: If you don’t see any

2. In the node editor, create the same mix of images as the
color, but use the black/white mask images. To do this, all we
need to do is create a copy of the Mario sprites’ Compound
Let’s play the animation and test all of the node wizardry. If it
all worked out, we should see the quick running cycle play as
the character moves, the stand sprite when the character stops
at frame 24, the run cycle play again as the character moves,
and the jump sprite when the character leaps into the air.
TROUBLE SHOOTING TIP: If you notice the character’s
jump sprite appear when it shouldn’t, it means that
there may be a slight amount of movement in the Y axis. This is
really just a quick fix in the graph editor.

node and the three mixer nodes. Select them all by holding
down CTRL, clicking on each, then copying (CTRL v) and pasting
(CTRL c) them back into the Node Editor.

improvements of the above mentioned anomalies in
All that is left to do is to hook the nodes back to the Logic and

the VPR viewport, click on the VPR options button (on the top-

Mod nodes as per their color and attach the final Mixer node’s

right of the viewport—left of the small floppy disk button) and

color output to the Surface node’s Transparency. This is exactly

make sure Draft Mode is unchecked.

the same as the color.

You can see in my image that I went through and carefully
renamed the other nodes. You can leave yours as-is, however
it can get quite confusing if you have a lot of identically name

To finish, let’s get the character to turn around when walking

nodes. Move these pasted nodes somewhere that will be easy

backwards.

to see (after you paste the nodes, they remain selected; simply

control the H rotation of our object.

We will do this by using Expressions that will

place the mouse pointer over one of the selected nodes and

1. Select the Mario object, and open the Graph Editor. Click on

click-drag).

the Expressions tab under the Graph Editor, and click New to
Obviously there are a couple of final touches we’ll need to

create the first expression. Change the name to TurnMario.

make if we want to create a working system here. For example,
make sure that the character is running in the correct direction
(you may have spotted the ‘backwards’ running!) The other is to

4.

hide all of the black blocks to ‘cut out’ the character on top of

problems with rendering or possibly odd visual artifacts like

any background we may be animating over.

transparent blocks. Move and rotate the camera to look edge-

We’re almost done. There’s a chance you will encounter

on at the character; it may appear that parts of the character
are breaking up. This is because we have a large collection of
blocks stacked on top of each other, and as the transparency is
Making the pixels around the sprite disappear is an easy
process. This is why we created two additional images as black
and white masks. The white mask will be used to clear blocks—
which is accomplished by using the transparency channel in
the nodes.

1.

rename it to Mario Masks to avoid confusion. Next, double-click on the Mario Masks node to open up the Compound
node. Double click on each of the image nodes and change

Let’s change the background color from black to something

brighter. Go to the Windows > Backdrop options (CTRL F5) and
simply click on the Gradient Background.
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3. Click on the copied Mario Sprites (1) Compound node, and
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the image by loading in the same-named images that have the
prefix A_.

2. The expression needs to test that the X channel is less than
the X channel of the previous frame. If it is, then the heading
should stay at 0 degrees (it is heading in the correct direction).
If it is moving the oppotsite direction, set the heading to 180
degrees. If you follow the logic we’ve been using with the
nodes, it’s pretty much the same thing.

calculated, it will only go so far before it stops and makes these

In the Value text box, clear the text that is currently present and

strange visuals.

start with an open bracket. The first thing we want is the mario.
Position.X channel. To quickly enter this into the expression,

The culprit here is raytracing. Under the Render Options (if

you can right-click on the Channel in the bin on the left and

you select your camera or light and open its properties (p) you

select the bottom menu option Append to Expression.

will bring up this window, and click on the Render tab) there
is a setting for Ray Recursion. The default is usually set to 6.
We can adjust this value to something higher (12 - 16 seems
to work well) to allow LightWave to trace deeper and give
cleaner results.

After adding this, type a space and a <, followed by another
space. Again, append the X channel to the expression so it
appears after the < character. Your expression should look like:
( [mario.Position.X] < [mario.Position.X]
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For the second channel we need to know its value from

Rename the expression to noMove. Simply edit the expression

the previous frame in the animation. To do this, simply place

by changing the < to <> (not equals). This will check if the X

the cursor inside the closing square bracket after the X, enter a

has moved at all (left or right) by asking if the X position is

comma followed by the word Frame (with a capital F) followed

different. If this is true, the character is obviously moving.

by -1. Add a closed bracket after the square bracket (see below).

( [mario.Position.X] <> [mario.Position.X,Frame-1] ) ? 0 : 180

3.

This will keep Bullet from processing any dynamic calculations
on Mario until the last keyframe at 100. If Mario wasn’t set up

( [mario.Position.X] < [mario.Position.X,Frame-1] )

7.
This part of the expression will evaluate whether the X is less

moving, it will return a 1). Change the 180 to 0 and press enter

than the X in the previous frame. We also need to tell it to set

to make sure that LightWave updates and stores the expres-

a value based on whether it was true or not. After the bracket,

sion. ( [mario.Position.X] <> [mario.Position.X,Frame-1] ) ? 1 : 0

4.

to do this, he would simply fall apart as soon as we played the

For the two values at the end, change to 0 to a 1 (so if its

animation. Not having dynamics kick in until frame 100 also
allows us to keep the keyfra me animation. When dynamics
are present on an object, it overrides any keyframe animation.

type a ? followed by a 0, a colon and 180 (see example below).
Press enter to ensure the expression is set.

8.

( [mario.Position.X] < [mario.Position.X,Frame-1] ) ? 0 : 180

the TurnMario expression and at the end of the 180 value

4.

If you click on the expressions drop-down list, select

start Bullet. Press play. Sit back, and enjoy watching Mario fall

expression, add * [noMove] ( [mario.Position.X] <> [mario.

5.

Select the mario.Rotation.H channel in the bin on the left.

Change the length of the animation timeline to 200 frames,

rewind the timeline, and click the Enable Dynamics button to
apart when he lands from his jump.

Position.X,Frame-1] ) ? 0 : 180 * [noMove]

Then, above the expression, click the Apply button. This will
connect the expression to the heading angle.

This tells the expression that the rotation value would be 180
degrees if it’s moving (since our noMove expression would
be returning a 1, and 180 * 1 is 180). If it’s not moving, the
noMove expression returns a 0. Anything multiplied by 0
is obviously, 0. That means if it’s not moving, just leave the
rotation at 0. Press Enter to make sure that the expression is
updated, and we’re finished!

Move the ground plane below Mario’s feet. If you prefer, you
can adjust the surfacing to make this look more interesting.

2.

Click on the FX Tools tab, and deactivate the Dynamics by

disabling the Enable Dynamics button. This will let us set this
up without Bullet interrupting by processing simulations as
we work. With the Ground plane selected, click on the Static
Body button to convert it to a collision object.

ANIMATED TEXTURES COMPLETE!

3.
Hit TAB to hide the Graph Editor and watch the animation
again. This time the character turns the correct way! Hoorah!
However, it flips after the character lands, and appears to flip
when the character is standing still. It should only change
direction when moving!
To correct this, we’ll need to tell the expression that it should
only change the rotation to 180 degrees IF the character
is moving.

Expressions are very simple statements, so

unfortunately we can’t create a long complex formula here to
check. But, we can create the extra logic to test for movement
as another expression, or what is termed a sub expression.

6.

A sub expression is designed to calculate things, and is not

applied directly to a channel. So, we’re going to literally create
another expression that does the same type of calculation and
decision making, rather than typing up a whole new expression.
Click on the Clone button to copy it.

Select the Mario object and click on the Parts button to tu rn

Obviously this system is not perfect—any still movement will

his pixels into pieces. Next, click on the Item Properties button,

still flip back to 0 degrees (doing the opposite of what we tried

and under the Activation tab, set Mario’s Initial Activation

to fix). But, it works great for fun retro projects and with your

option to Activate On Last Key.

new-found technical skills in Expressions and Nodes, challenge
yourself to see if you can perfect the technique!

GAME OVER
In this tutorial we’ve looked at Node-based texturing and the
use of Logic, Math, and Compound nodes to produce quite a
technical system. For those who believe nodes are complicated
and confusing, I encourage you to do this tutorial again, perhaps
with a different set of sprite images to challenge yourself as
you work through the process. Nodes are extremely powerful
and offer artists many creative solutions to take workflow to
all new levels of success.

IT’S BEEN A SHATTERING EXPERIENCE
FOR MARIO
We’ve been concentrating so hard on all the technical set up
for this project, let’s release a little of the stress by smashing
Mario into lots of pixel blocks! The best tool for the job is of
course LightWave’s Bullet Dynamics! We’ll do this stage fairly
quickly as it’s a very easy process (which is one of those qualities that makes LightWave so great to work with).

1.

Under the Modeler Tools tab in Layout, go to the Create sec-

Kevin Phillips hails from the green shores of New
Zealand and has been working professionally with
Lightwave since 1994. Over the last 20 years, Kevin
has worked as a freelancer, a CG generalist at Flux Animation
Studios and is currently tutoring the new generation of artists at
ACG Yoobee School of Design. Kevin continues to help promote
the creative CG community and provide support for local artists
through monthly meetings at the New Zealand LightWave users
group ‘Kiwavers’, a network that he set up back in 1997.

tion, click on the Geometry drop down and select the Ground
Plane. Use the default settings and click the OK button.
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Bring on
the Turbulence
Creating a “Sharknado 2” Worthy CG Tornado with LightWave 3D and TurbulenceFD

DOWNLOAD

CONTENT

Who doesn’t love a tornado?
DEMO

VERSION

A simulated tornado that is. In this

TurbulenceFD is a complex tool, but we’ll

tutorial, we’ll use LightWave 3D and the

quickly dive into the settings of the program

TurbulenceFD plugin

(click the demo

to demystify the program’s interface and

button above to get the free demo version)

explain how a few simple settings can

to quickly learn the “nitty gritty” of using

help you achieve incredible results. After

the two programs to create tornadic

you’ve completed the tutorial, you should

effects similar to the ones I created for the

be ready to start experimenting with other

recently aired Syfy movie “Sharknado 2.”

controls in the software to build on and
refine your skills in TurbulenceFD.
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Step 9 -

Now load the Collider, set Display

Subpatch to 12 and nip into the Deform/Displacement

Setting up LightWave

properties again. Apply these settings: Fractal Noise |
Value 0.085 | 150mm in all 3 axes.

Step 1 - Load up Modeler, and create a disk, 40cm
wide by 5m tall. We’re going to be using it as a Subpatch, so try

It may look a bit wacky, but don’t worry, it’s what we want.

to keep your sections square. The settings in the screenshot

Now, let’s add keyframes.

work well.

Step 4 - Use the Layers Panel to line up the new
chain with the core object, so there’s about 200mm-250mm
separation.

Step 7 -

Under the Multiply tab, find the Thicken

control. Collider geometry needs actual thickness to work
properly—volumes don’t really know how to collide with zerothickness idealized planes. Hit Tab to Subpatch your resulting
funnel, and save it as Collider.lwo.

Step 10 - For each object, go to Frame 10 and
Step 2 -

Using the Taper Constrain tool, flare

set a Heading key of -90 degrees. Open the Graph Editor

out the top of the cylinder by 1/3 and taper the bottom by

(Ctrl-F2), select the Heading channel, and set its Pre and

approximately 1/3. This will create the basic shape of the

Post behaviors to Linear. Do this for both the core and the

tornado. Delete the top polygon, and merge the bottom

collider. Why select a Pre behavior? Because sometimes

vertices to eliminate the one on the bottom. Next, hit Tab to

it’s nice to be able to simulate from frame minus one

turn it into a Subpatch object and save it as “Core.lwo.”

hundred, for example, to let your volumetric simulation
get itself established before the shot actually starts. This

Step 5 -

is also known as “Preroll.”

With the chain selected, tap e for Edge

Extend, then v for Set Value, and set the X value to 0. This

On to Layout

creates the profile plane.

Step 8 -

Load the core object. Bring up Object

Properties and set Display Subpatch Level to 12. That’s
the displacement level TurbulenceFD will respect during
simulation.
Go to the Deformations tab and apply the following as a
Displacement Map: Fractal Noise | Value 0.03 | 250 mm in XYZ.

Step 3 - Next we will create the Collider. We want
the Collider to have the same profile as the core, but wider.

When installing the TurbulenceFD plugin, import its menu

In the top view, select 1 row of vertices, and copy them with

branch into the FX Tools tab. If you’re working with the

Ctrl-v. Hit Shift-n for a new object, and paste. Next, select the
vertices, moving downward. Under the Make Polygon group,
select Create Poly Chain.

Step 6 - Shift-L will bring up the Lathe tool. Again,
give it 12 sides to match the core object and delete the top

demo version, we will assume that you know where you
put your menu branch.

and bottom polygons.
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Step 11 -

Add a Fluid Container and name it

whatever you like. On complex projects, I always start fluid

We want our vapor to have a fairly fast life-cycle, to keep
things nice and tight, so set the Half-Life to 8 frames.

Step 15 - Go back to the Containers panel, click on
the Viewport Preview tab, and set the channel to Density.

container names with “Fluid_”—for example, Fluid_Tornado,
Fluid_Tornado_Base, and so on. Doing this makes scene

Step 13 - To add some nice swirly turbulence,

organization much easier and stops my co-workers from

click the Turbulence tab, and match my values: 200mm

wanting to use me as a piñata.

Intensity, 50mm smallest size, and 100mm biggest size.

Let’s keep the 20mm voxel size, but increase the grid size
to 3m in X and Z, and 6m in the Z to completely enclose the
tornado’s parts.

collider objects, and in the Render tab set Object Dissolve
to 100%--we don’t want to render that, and we don’t really
want to see the geometry either, just the volume.
Organize your viewport to have a nice view of the Fluid
Container. Make sure the Draw mode is set to Textured

Now we just need to set up our core and collider to

Shaded Solid, and hit the Start button in the TurbulenceFD

actually do things in TurbulenceFD.

Containers Panel.

Step 16 -

Now click on the Rendering tab, the

Smoke Shader Sub-tab, and the Mapping tab under that
(complex beast, isn’t it?) and set that channel to Density, too.

This is a good time to set a cache directory as well. Be aware
that TurbulenceFD can produce some pretty monumental
cache files. If you put your mind to it, it’s pretty easy to fill a
terabyte hard drive. In this image, my Cache Directory is called
“TFD_Cache,” but the Relative to Content Directory button is
checked. It’s pretty straightforward.

card’s GPU—look for a “Use” dropdown near the Start

Channels tab and enter a density value of 4. When I first

button. If you don’t see your GPU listed in there, this is

started using TurbulenceFD, I made the mistake of trying

probably a good time for you to get a cup of coffee. Either

really low density emission values for thin or wispy vapors.

way, you’ll start to see swirly, cloud-like things forming in

This led to nasty sharp edges and even banding in the
volume. Emitting values greater than 1 gives more control

Frame 0 move the Fluid Container to encompass the objects.

when it comes to mapping the renders. You can always
reduce data that you already have, but if you didn’t create

Now let’s set the parameters for

you can set TurbulenceFD to simulate on the graphics

Emitter. The Fluid Emitters panel will pop open. Go to the

Next, pop over an orthographic view, right or front, and at

Step 12 -

If you have a powerful, graphics card in your workstation,

Step 14 - Select the core object, and click Make

enough data, you can’t manipulate it accurately.

the simulation. Click TurbulenceFD’s Simulation Tab, and the

your viewport.
Congratulations! You’ve made a tornado. Make a Preview

Step 17 - Finally, click on the Color & Opacity Sub-

to see it all its wibbly, swirly glory. You will probably notice

tab of the Smoke Shader subt-ab. Set Thickness to 60, and

that it takes a few dozen frames for the simulation to start

Brightness to 40%.

doing what you actually want it to, which is why we set the

Density Subtab. Density is what I generally use for smoke,

constant rotation on our objects in both directions. If you

vapor, and so on. It dissipates and swirls and can fall under

set the first frame at -100, your tornado will be tornading

gravity, but doesn’t do any active heating or expansion on its

nicely by the time it reaches frame 0.

own. Check the “Active” box.

“Are you wondering why you made a collider object?” Well,
the Density in a TurbulenceFD volume, much like smoke
or mist in the real world does not carry a lot of inertia. If
you remove the Collider from the Emitters Panel and run
your simulation again, you’ll see the vapor kind of drifts
away and comes to a halt while the inner core keeps
whirling along in at a frenzied pace. In a real tornado,
there’s a vortex of wind whipping in a tight circle—the
Select the collider object, and click Make Collision. It will
show up in the Fluid Emitters panel.
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Now that you’ve made it though the tutorial, let’s test
additional fun things to do with TurbulenceFD and
LightWave. In previous editions of the “LightWave 3D
Magazine,” both Spline guides and Instancing have
been covered quite thoroughly. While working on
“Sharknado 2,” I used both of these features, putting
bone chains down the core and in the collider while
the Spline Guide helped me animate the curvature of
the tornado. By using Instancing, I was able to stuff
those tornadoes full of vicious, man-eating sharks.
You can also experiment with using Particles stirred
with LightWave’s wind dynamics to beef up the
tornado with exterior mist layers. Also, if you read
the TurbulenceFD documentation on Sub-Grid Detail,
you can really divide up the render’s detail levels to
avoid using all the RAM in your machine.
It’s astonishingly easy to use LightWave and
TurbulenceFD to make really rich and visually
impressive effects. Happy simming!

Mark Hennessy-Barrett is a LightWave
artist who began working with the software
in 1993 and proclaims he “hasn’t been
caught yet.“ A seasoned modeler, texture artist, lighter
and animator, Barrett currently specializes in dynamics
and volumetrics. His favorite color is “Explosion.”
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By Jennifer Hachigian

Fitting in with Ray Cast Geometry

Fitting In
With Ray Cast Geometry

TUTORIAL

DOWNLOAD

CONTENT

An in-depth tutorial highlighting the benefits of using Ray Cast Geometry Nodes in LightWave 11.6.

LightWave 11.6 introduced the Ray Cast Geometry node,
which allows one to better fit items and instances to
geometry. This tutorial will show how to fit a sheet of toy
bricks to a deforming plane of geometry.
The first step is to build the geometry that we will use in
this tutorial.

Step 1
Launch LightWave Modeler 11.6.3, type SHIFT-X to activate
the Box tool and then type N to bring up the Numeric panel.
Enter a Width of 16mm, a Height of 10mm and a Depth
of 32mm.

Step 2
Hit the Spacebar to drop the Box tool, leaving the
box behind.
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Step 3 -

Hit F3 to activate Rest on Ground. Make

Step 6 -

Go to Create->Disc. In the Numeric panel

Step 9 -

Deselect all geometry by clicking in the

empty space of the menu toolbar on the left-hand side.

by the T button), but let’s try a new tool introduced in 11.5 that
offers more precision over Moves – Axis Translate. Go to Modify-

sure the Rest Axis is set to Y and that all three checkboxes are

for Disc, use Y for the Axis, 48 for the number of sides, 1 for

checked (Center: X Axis, Y Axis and Z Axis). Leave Sense set to +

the number of Segments, a Bottom of 0 and a Top of 2 mm,

>Axis Translate to activate the Axis Translate tool. A number of

so that the geometry will rest on the positive side of the Y axis.

a Center of XYZ 0 1mm 0, and a Radius of XYZ 2.4mm 1mm

snapping options appear in the lower left-hand side, and all seven

Hit OK to center the geometry.

2.4mm. Hit the Spacebar to drop the Disc tool.

snapping options are active by default. These snapping options
can be activated/deactivated by clicking on them.

Step 10 -

Type CTRL-Y to activate the Array tool.

Use an Array Type that is Rectangular, an XYZ Count of 2 1 4,
an Offset Type of Manual, and an Offset of XYZ 8mm 1m 8mm.
Click OK to create an array of eight nubs.

Step 4 -

Type CTRL-H to enter Polygon Mode, then

CTRL-B to activate the Chamfer tool. With no specific polygon(s)

Step 7 -

Step 13 -

In the Back View, right-click and lasso the

In the Perspective viewport, hover your

mouse pointer over the middle of the “floor” polygon in the

top-most polygon to select it.

selected, every polygon will be affected by Chamfer. Next, in the

background, which happens to be smack on top of the Origin

Numeric panel, type in 0.2mm (or 200um) to give this box slightly

in Modeler. You should see “Origin” appear near your mouse

rounded edges. Hit the Spacebar to drop the Chamfer tool.

pointer.

Step 11 -

Type F3 to bring up the Rest on Ground

tool. Use the same settings as in Step 3 and click OK to center
this array of nubs.

Step 8 -

Repeat the method in Step 4, using

Step 14 -

Chamfer to give the nub a rounded top with a 200 um bevel. Hit
the Spacebar to drop the Chamfer tool.

Step 5 -

Left-click and drag to the polygon center

of the top brick in the background. When the text says “Polygon
Center,” let go to place the nubs on the top of the brick. Hit the

Go to Layer 2 and make Layer 1 a

Spacebar to drop the tool.

background mesh.

Step 12 - Now we need to move the nubs to the top
of this brick. We can eyeball it with the classic Move tool (accessed
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Step 15 -

Cut-and-paste the geometry from Layer

2 to Layer 1.

Step 18 - Use File->New Object to start a new object
in Modeler.

Step 20 -

Because this sheet is meant to be

Step 24 - Select the 1mPlaneTripled object and type

deformed, it should be tripled to eliminate any risk of non-

P to open Object Properties. Click on the Deform tab of Object

planar polygons during deformation. Ray Cast Geometry does

Properties. At the bottom of this panel, click on Add Displacement

not like analyzing non-planar polygons. Type SHIFT-T to triple

and choose Texture Displacement.

this sheet of polygons.
Double-click on Texture Displacement to bring up the Texture
Editor. Change the Layer Type to Procedural Texture, and then
change the Procedural Type to Underwater. Enter a Texture
Value of 0.1, Wave Sources of 1, Wavelength of 0.5, Wave Speed
of 0.0063 (for slower speed), and Band Sharpness of 2.0.
Reducing the Wave Sources from its default of 3 to 1 creates
concentric circles that expand outward at the speed defined
by Wave Speed. The default Wave Speed of 0.025 is too fast;
reducing it to 0.0063 gives it a more relaxed feeling. Try making

Step 16 - Deselect all geometry and type Q to bring

Step 19 - Type SHIFT-X to activate the Box tool. In its

up the Change Surface panel. With nothing selected, every

Numeric panel, enter a Width of XYZ 1m 0m 1m, a Center of XYZ

polygon will be affected by this Change Surface operation. Give

0m 0m 0m, and Segments of XYZ 100 1 100. Hit the Spacebar to

all of this geometry a surface name of “Brick” and click OK to exit

drop the Box tool, leaving a sheet of polygons behind.

the Change Surface panel.

a Preview to see if you like the speed, and play around with the
Procedural settings until you get a deformation that you like.

Step 21 -

Save this sheet of polygons to disk as

“1mPlaneTripled.lwo.” We now have the geometry we need for
the rest of the effect. The next steps will take place in Layout, so
you may close Modeler if you wish.

Step 25 - It’s a good idea to save the work you have
done so far. Save this scene as BrickWave_v001.lws.

Step 17 - Save this object to disk as “Brick_v001.lwo.”
Step 22 - Launch LightWave Layout 11.6.3.
Step 23 - Load Brick_v001.lwo and 1mPlaneTripled.
lwo into Layout. First, we will create a cool ripple displacement
on this plane.
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Step 29 - In the Item column, click on Brick_v001 to

OffsetMax, which affect the Random setting). We have a sheet

to this scene. Its sole purpose is to generate instances, so give

access its settings. We would like to create a sheet of instances,

of instances. Now we need to conform them to the sheet of

node to open up the Ray Cast Geometry settings. We want it to

it a name that makes sense. Call it “InstanceGeneratorNull” and

so change the Type to Rectangular Array. The default spacing is

polygons. We can do this with a little Ray Cast Geometry magic.

“see” the 1mPlaneTripled object, so add a checkbox to

click OK to add a null with that name to the scene.

not 1 brick apart, so change the XYZ Spacing to the size of the

1mPlaneTripled. Leave everything else at its default, then close

box that you made in Step 1 – XYZ 16mm 10mm 32mm.

the settings.

Step 26 - Use Items->Add->Null to add a Null object

Step 34 -

Double-click on the Ray Cast Geometry

This will generate a 5x5x5 array of tightly spaced bricks,
centered about the null object.

Step 27 - Select this null object. Go to the Instance

Step 32 - Go to the Nodes tab and activate the Use

tab in its Object Properties, click on Add Instancer and add an

Nodes checkbox. Then click on Edit Nodes to open the Node

Instance Generator.

Editor interface.

Step 30 - We need a sheet of instances, not a block.
Change the number of instances to XYZ 60 1 30. In the Bottom
view, you can see that this just fits the 1m-sized sheet without
exceeding its borders.
We have a sheet of instances. Now we need to conform them
to the sheet of polygons. We can do this with a little Ray Cast
Geometry magic.

Step 35 - Plug the Base Position of the Input Node
into the Ray Origin of the Ray Cast Geometry node. Then plug
the Intersect of the Ray Cast Geometry node into the Offset of
the InstanceGenerator node. The instances will spread apart,

Step 28 -

but they will not conform to the sheet.

Double-click on the Instance Generator

Step 33 - In the search engine, type in “ray” to find

to open up its options panel. We would like to create a sheet of
bricks, so click on “Add Object” and select the Brick_v001 object
to add it as an instance.

the Ray Cast Geometry node. Double-click on its name to add it

This is because the default Ray Direction points “down” instead

to the Node Editor.

of “up.” We’ll fix that on the next step.

Step 31 - In the Offset tab, change the Mode from its
default of Random to Uniform. We’re going to be using nodes to
control this setting, and changing it to Uniform means we only
have to plug the results into one input (Offset, which affects
the Uniform setting) instead of two inputs (OffsetMin and
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Fitting in with Ray Cast Geometry
In the Node Editor search engine, type

And if a third brick is floating at 17.9mm on the Y-axis, it’s

its settings. Change its Y-value from 0.0 to 1.0. The instances

“vect” to bring up the two nodes that we’re going to use to

7.9mm above 10mm. So if we subtracted 7.9mm from 17.9mm,

now conform to the polygon sheet.

replace the Multiply node: Make Vector and Vector Scalar. Add

we would have 10mm even.

both to the node flow. Connect Intersect to Vector, Scalar to Y,

A formula for the above three bricks might be: Y – (Y % 10mm)

and Vector to Offset.

In the above equation, “%” means “mod.” “Y%10mm” means

Step 36 - Open up the Ray Cast Geometry settings

Step 38 - Double-click on the Multiply node to edit

again and change the Ray Direction Y-value from its default of
-1.0 (pointing “down”) to 1.0 (pointing “up”). The instances now
follow the ripple-shape of the polygon-sheet, but they are still
spread apart.
This is because Intersect returns the exact XYZ value where
each ray fired by Ray Cast Geometry intersected the sheet of
polygons. For example, if an instance placed at XYZ 0.5 0.0 0.5
fires a ray straight up, and that hits the sheet at XYZ 0.5 0.3

So far, so good, but our toy bricks are bobbing up and down
like they’re on water instead of interlocked together at precise,
brick-sized intervals. We need to snap their Y-positions to the
closest brick-sized position, instead of allowing them to freely
move up-and-down on the Y-axis.

Step 41 -

The results do not match those of the Multiply node, because
we need to tell Vector Scalar what data we want extracted
from Intersect.

“Y mod 10mm.” An alternate description of “Y mod 10mm” is
“the remainder left over after dividing Y by 10mm.” So if Y is
12mm, “Y%10mm” would give 2mm, the remainder left over
after dividing Y by 10mm. If Y is 23mm, “Y%10mm” would give

0.5, Intersect will return a value of XYZ 0.5 0.3 0.5. When that

3mm, which is the remainder left over after dividing Y by 10mm.

Intersect value is plugged into Offset, that specific instance will

So if Y is 23mm, the above equation will return 20mm: Y – (Y

get shifted over a half-meter on the X and Z in addition to the

% 10mm) = 23mm – (23mm % 10mm) = 23mm - 3mm = 20mm

0.3 movement up on the Y.

So we have a formula that will give us what we want. Now we

We do not need the X and Z values–we just need the Y-values.

just need to apply it to our Node Editor graph.

We need to zero out the X and Z information while keeping the
Y information.

Step 39 -

Now might be a good point to save out

BrickWave_v002 by typing SHIFT-S.

Step 42 - Double-click on Vector Scalar to open its
interface. Change the Mode from its default of “Maximum” to “Y
Channel.” The instances now once again conform to the sheet
of polygons.
We have now isolated the Y Channel. What we now need to
do is to tell each instanced brick to snap to the closest 10mm
increment, because each brick is 10mm high (not including its

Step 37 - In the Node Editor search engine, type in

nubs). For example, we want to have a layer of bricks stacked

“mul” to find the Math->Vector->Multiply node. Add the Multiply

at 0mm on the Y-axis, the next layer stacked at 10mm on the

node to the Node Editor, and plug the Intersect value into A and

Y-axis, and the next layer stacked at 20mm on the Y-axis.

the Result into Offset.

Right now some bricks might have Y-values of 1mm, some

You can’t see it now, but the value of “B” is XYZ 0.0 0.0 0.0.

bricks have Y-values of 12.6mm, and still other bricks might

Anything times zero equals zero, which is what we want for X
and Z. However, we have also zeroed out all of our Y values! We
will fix this in the next step.

Step 43 -

Search for “mod” in the Node Editor to

uncover the Mod (Math->Scalar->Mod) node, and add it to the
graph. Connect the Scalar output of Vector Scalar to the A input
of Mod. Double-click on Mod to open up its settings, and enter
10mm for the value of B. It will auto-convert to 0.01, which is the
equivalent value in meters.

have Y-values of 25.7mm. We want these bricks to snap to

Step 40 - We need finer control over the Y-channel,

Y-values of 0mm, 10mm, and 20mm. We can do this by finding

so let’s replace the Multiply node with two nodes that do the

the difference between the actual Y-values of these bricks and

same thing. Select the Multiply node and type the Delete key on

the closest 10mm increment on the Y-axis, and then subtracting

your keyboard to delete it.

that difference from the brick’s Y-value to make it snap to that
closest 10mm increment.
For example, suppose a brick is floating at 25.7mm on the
Y-axis. It’s 5.7mm above 20mm, so if we subtracted 5.7mm from
the original Y-value of 25.7mm, we would have 20mm even.
Suppose another brick is floating at 13.8mm on the Y-axis. It’s
3.8mm above 10mm, so if we subtracted 3.8mm from 13.8mm,
we would have 10mm even.
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Search for “sub” in the Node Editor to

Then scrub to frame 0 and go to Camera mode (SHIFT-C). At the

Interpolated. Reduce the Rays Per Evaluation from its default

You may use any image map or procedural texture you wish to

find the Scalar version of the Subtract node (Math->Scalar-

top of the window, there is a little drop-down menu represented

of 100 to 20.

paint the “sphere” that represents the Backdrop of this scene.

>Subtract), and add it to the Node Editor. Connect an additional

by an arrow. Click on it, choose “Match Perspective,” and

So far, so good, but Backdrop doesn’t look very exciting when

For this step, let’s use a Gradient Layer Type. Change the Layer

Scalar output from Vector Scalar to the A input of Subtract.

then choose “Selected Camera.” This will apply the current

the backdrop is left at its default of pure black.

Type to Gradient. Change the Input Parameter to Pitch. For

Step 44 -

Connect the Result output of Mod to the B input of Subtract.

Perspective View’s Position and Rotation settings to the

Pitch, -89.99 represents the top of the sphere, while 89.99 rep-

Connect the Result to the Y-Input of Make Vector.

current Camera.

resents the bottom of the sphere. The Gradient starts with a
single white key at the top of the gradient. Add a second, black

The instanced bricks now snap to the nearest 10mm on the

key to the bottom of this gradient. Now the backdrop sphere

Y-axis, for a better “toy brick” appearance.

is casting white light from the top that fades away as the sides

Save your work as BrickWave_v003.lws. We will now move on to

fall off.

rendering this wave of bricks.

Feel free to change the colors of these keys and/or add new
keys to control the lighting of the Backdrop Radiosity. As a general rule, the upper keys should be lighter than the bottom keys
in order to represent the colors cast by the sky and the ground.
With Backdrop Radiosity filling in the shadows, our shadows are
now less stark than they were before. However, it’s clear that

Step 49 -

Type CTRL-F5 to open the Backdrop

tab of the Effects panel. Here we have three ways to control

Step 47 -

Type 6 to switch from the Perspective

View to the Camera view.
You are in the Camera mode right now, so type P to bring up

Step 45 -

We want the instanced toy bricks to

render, but not the deforming plane or the source brick. In
the Scene Editor, uncheck the 1mPlaneTripled and Brick_v001
objects so that they will not render.

uniform color to the entire backdrop. Right now it is set to a
uniform black.
Activate the “Gradient Backdrop” checkbox to quickly apply a

the Resolution drop-down list, choose HDTV (1280x720) to load

gradient color to our backdrop. If our backdrop could be seen

a Width of 1280 and a Height of 720 into the Camera properties.

as a sphere, the default Gradient Backdrop would paint this

to VPR to see what will render when you hit F9. It looks like a
stack of bricks, but it’s not the best-lit bricks.

tweak to our Instancing, then we will move on to our surfacing.

the backdrop color. One way is Backdrop Color, which gives a

its Properties, which are part of the Render Globals panel. From

Change the View mode from Textured Shaded Solid Wireframe

there are gaps between the toy bricks. We will make one more

sphere with sky-blue tones at the top and earth tones at the
bottom hemisphere. For a quick-and-dirty Backdrop Radiosity
lighting setup, it’s not bad at all.

Step 51 -

Pull up the Instance Generator settings

for the InstanceGeneratorNull object. Right now our sheet of
toy bricks is one brick thick. Let’s make it three bricks thick in
order to fill in the gaps. Change the number of Y Instances from
1 to 3. The gaps disappear as the extra bricks fill in the blanks.

Step 46 - We should move the camera to get a good
view of this wave of bricks. One way to place the camera is to

Step 50 -

For the most control over the backdrop

take advantage of the Match Perspective option introduced in

Step 48 - With the Render Globals panel still open,

color, we can use Environment Plugins. Deactivate Gradient

11.6. In the Perspective View, hit SHIFT-A to autosize the view to

go to the Global Illumination tab. Turn on Enable Radiosity.

Backdrop to follow this step, or move to the next step if you’re

the wave of bricks. Adjust the zoom of the Perspective View to

It defaults to Monte Carlo, which can be pricey if we don’t

happy with the look of the Gradient Backdrop.

get a good look at the bricks.

need bounced light. Change it to Backdrop Only, and disable

Click on Add Environment and choose “Textured Environment.”
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Step 52 - By default, VPR has Draft Mode turned on.

Step 54 -

Activate the checkbox to the right of the

This can be faster, but it makes radiosity look splotchy. In the

“Edit Nodes” button, then click the “Edit Nodes” button to open

upper-right-hand corner of the viewport, click on the small icon

up the Node Editor for the Brick surface.

After you are done adding each key, click on “Distribute Keys” to
evenly distribute the keys and their range of colors.

with three lines to access the VPR settings. Disable Draft Mode

Tip: Find a picture of toy bricks online, then use the

to get a cleaner look in VPR. Now we have lighting and VPR. Save

LightWave Color Picker’s “Pick from Screen” ability to

this scene as BrickWave_v004.lws.

select colors directly from the picture of the toy bricks.
You are almost done with this scene! However, you must follow

settings that we like. Save this scene as BrickWave_v004.lws.

the next step to preserve your surfacing.
Surfacing information is not stored in the LWS scene file. It is
stored in the LWO object file. If you save this scene without
saving your LWO, you will lose your surfacing information.
settings that we like.

Step 55 -

Add an Instance Info node (Spot-

>Instance Info) and a Gradient Node (Gradient->Gradient) to
this Node Editor. Connect the Instance Info’s “Fixed Random”

Step 53 -

Type F5 to open up the Surface Editor.

to the Gradient node, then connect the Gradient node’s Color

Uncollapse the Brick_v001 list and select the Brick surface.

output the the Color Input on the Surface node. The color will

Activate the Smoothing checkbox. We don’t want this to smooth

turn black, because the Gradient Color defaults to black.

everything, so change the Smooth Threshold from its default of
89.53 to 35 degrees. This way the Smoothing will still work on
the Chamfer bevels, but the Smoothing won’t bleed over to the
sides of the boxes or the tops of the nubs.

“Fixed Random” gives each instance a value between 0.0 and
1.0. The Gradient node, by default, interprets a range of input
values between a Start value of 0.0 and an End value of 1.0.

A Specular highlight from the Distant light might be nice. Set
the Specularity to 80.0% for a bright highlight, and lower the

settings that we like. Save this scene as BrickWave_v004.lws.

Glossiness to 25.0% for a greater spread on this highlight. Now,

Step 57 - Select the Brick_v001 object. Go to File >
Save As and save it out as Brick_v002.lwo.

let’s vary the colors.
We’re not done yet! The current scene still points to Brick_v001.
If you do not save the scene information, the next time you
load this scene it will point to Brick_v001 instead of Brick_v002.
Type SHIFT-S to save the scene as BrickWave_v005.lws.
You’re done! You can now either make a Preview, or render
these frames to disk.

Step 56 - Double-click on the Gradient node to pull

Happy ‘Waving!’

up its interface. Left-click on the Gradient to add new keys and
colors. Click on any given key to select it and change its settings.

Jennifer Hachigian works in Burbank, California as a

If you make too many keys, click on the “x” box on the right-

LightWave 3D artist. Some of her many credits include

hand side of the key to delete that key.

“The Amazing Spiderman” and “Mockingbird Lane.”

In real life, you only see a few colors in a set of toy bricks, not
millions. For each key, change the Smoothing from its default of
Hermite to Step to limit the range of colors for these toy bricks.
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A Rendering
Punch

Otoy’s Octane Render has long been touted as
the world’s fastest unbiased photoreal renderer.
And, as a LightWave artist, who uses Octane Render 2.0 regularly, I find the benefits of pairing the
two very rewarding. In fact, when I first learned
of the new promotion from the LightWave 3D
Group that offers LightWave 11.6 and Octane
Render 2.0 for only $1595 (registered upgrades
from LightWave 10 or earlier are $995), I thought
this would be a bundle that will have 3D artists
delivering some seriously impressive work.
While LightWave’s radiosity renderer packs a
powerful punch, its performance is tied solely
to the workstation’s CPU. But, when paired with
Octane Render, which is a fully GPU-accelerated
renderer, the rendering in LightWave benefits
from the speed of the GPU and the performance
of the video card.
One great advantage of Octane Render with
LightWave is that a good NVIDIA graphics card
(a must have for any 3D artist), can render performances that really reach the outer limits,
even when Path Tracing or PCM are used. The
LightWave renderer gives you a lot of control
over lighting and shading to achieve ‘physically
correct’ results. But for those who prefer to get
physically correct renders upfront, Octane Render complements LightWave’s powerful internal

Packing
a Rendering Punch

render very well.
Octane Render can improve nearly any type
of production, and is integrated so well with
LightWave that it supports a majority of
LightWave’s features. For example, it can render
LightWave’s polychains as hair/fur, using an
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this task while reducing memory usage by
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as much as 20 percent. Octane Render also supports hair rendering
from two vertex polygon chains that you can get from the LightWave
Modeler’s FiberFX plugin or from ZBrush.
On a side note, The LightWave User Group is currently working on the
FiberFX API to provide full support of fibers for external renders, making
it possible to “pass” any information defined in FiberFX to Octane Render.
Image by Joseph Lawson

Another helpful feature of Octane Render is that it fully
supports Instances in LightWave, and sees them as Instances.
So, you can set up Instances in Layout and have them render
in Octane Render fast and efficiently.

Visual effects & compositing program

3D for photographers & graphic designers program

Lightwave 3D essentials program

FX Animation Barcelona 3D School
Lightwave 3D Certified Training Center

Whatever project you are working on, with LightWave and Octane Render together you can expect rendering speed increases of 5x to 20x. Special shading algorithms in Octane Render
recalculate normal near-sharp edges and corners, making
them appear smooth, all without having to refine and reload
the geometry. Moreover, you can change camera viewpoints,
lights, materials, and object positions, and see those scene-

Image by Shaun Bishop

editing changes almost immediately in the viewport.

Teaching
training in ENGLISH.
Accommodation
in Barcelona
included.

The tool uses the Layout animation information – environment, lighting,
and so forth – and renders that data. However, if you want to create
complex materials, those materials have to be built using the Octane
Render nodes. Even if it can read the color, diffuse, and reflection,
you need to rely on Octane Render’s own system to create complex
materials.
Image by Shaun Bishop

Some of the new features in Octane Render 2.0 include microdisplacement, enabling you to adjust the height of surface points based
on images or procedural textures values, giving objects more depth and
detail. Now, object motion blur can be applied independently of camera
movement, while vertex motion blur can also be added.
The LightWave 11.6 and Octane Render 2.0 bundle, including the
Standalone Edition and an Octane Render for LightWave plug-in license,
for new users is priced at $1595 (US). Registered LightWave 10 and earlier
users can upgrade to the bundle for $995. LightWave 11.6 is regularly
priced at $1495, Octane Render 2 sells for 439 Euros (approximately
$600 USD), and upgrade pricing for LightWave is $695. To me, this is a

Image by gordonrobb

very cool offer, indeed.
By Jesús Sanz (FX Animation student).

Follow us:
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Lino Grandi is a 3D artist and animator who spends his days
working at the LightWave 3D Group as the 3D content and
character technology lead.

Barcelona · Spain · Europe

www.fxanimation.es / www.barcelona3dschool.com
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international@fxanimation.es - Skype: yago.fxanimation

“...I was impressed when I saw the quality of the work
that the students give after attending the FX Animation
3D School.”
Rob Powers, President of LightWave 3D Group.
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